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Ogni tanto nel mondo dell’informatica nasce un software
difficile da classificare, diverso da tutto quello che esisteva
“prima”.

Non succede spesso, ma abbiamo la sensazione che iPer
Hyper Publish PRO (o più concisamente HyperPublish) sia
proprio questo: non si tratta di un wordprocessor, né di un
editor HTML, non è un programma per la creazione di CD
multimediali né un editor per e-books o guide di Windows, ma
tutte queste cose assieme, e forse anche di più.

Con HyperPublish abbiamo voluto portare avanti la
scommessa di realizzare un punto di incontro comodo tra
diversi mondi, uno strumento estremamente generale ed allo
stesso tempo estremamente semplice da usare.  Questo ha
richiesto un prolungato impegno nel design dell’interfaccia
utente, e un certo coraggio nell’introdurre primi al mondo
soluzioni ardite come il WYSIWYL (“vedi quello che colleghi”),
l’esclusivo ambiente che permette di navigare tra i
collegamenti senza bisogno di passare ad una preview, e di
crearne di nuovi navigando in un’anteprima.

Quella che avete fra le mani è l’ultima versione di questo
strumento completo, semplice e veloce, aggiornata grazie ai
vostri continui suggerimenti.

Siamo fieri di presentarvi questo software che vediamo
prima di ogni altra cosa come espressione pratica della
filosofia della Visual Vision: amore per il design, per la
semplicità di interazione e per la concretezza.

Ci auguriamo che l’utilizzo di HyperPublish per le vostre
esigenze dia a voi la stessa soddisfazione che noi abbiamo
provato durante le fasi di progetto e realizzazione.

Ing. Aldo Ghigliano
Direttore, Visual Vision
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7yperPublish è uno strumento
“ tutto in uno” per realizzare sia siti Inter-
net che CDROM multimediali / iperme-
diali .

Servirsi di CD o siti Web è oggigiorno
il modo più eff icace (e spesso più econo-
mico) per trasferire informazioni di qua-
lunque genere. Cataloghi, manuali , pre-
sentazioni, libri e semplici siti aziendali
sono tutte applicazioni realizzabili con
poco sforzo usando HyperPublish.

Sebbene la gamma di funzioni a dispo-
sizione sia molto completa, tanto che a
prima vista le opzioni possono sembrare
persino troppe, la caratteristica più impor-
tante attorno a cui è stato progettato il
programma è la immediatezza e la velo-
cità nell ’uso di tutti i giorni.

HyperPublish infatti non è per
“ maniaci” del codice e della perfezione
tecnica (ad esempio nella generazione di
pagine Internet non si vede per nulla il
famigerato codice HTML, anche se il pro-

gramma si fa carico della generazione e
persino della compatibilit à automatica con
tutti i “ browser” Internet più diffusi).

E’ invece pensato per l’uso di tutti i
giorni, molto simile ai wordprocessor
usati comunemente in tutti gli uff ici per la
stampa su carta.

Le differenze principali rispetto ad un
wordprocessor sono due: la prima è che
HyperPublish permette di “ stampare” , in-
vece che su carta, su Internet o CDROM,
attraverso semplici Wizard. La seconda è
che le pagine gestite non sono semplici
pagine “ a sé” ma possono contenere colle-
gamenti ipertestuali (cioè parole o imma-
gini “ cliccabili ” che portano verso sezioni
interne o verso documenti separati).

L’ impostazione semplice e potente
dell ’editor permette di usare stili , tabelle,
mappe, insiemi di cornici, diapositive, mo-
duli e finestre volanti, senza sforzo e in
modo visuale, WYSIWYG, cioè tutto
quello che si realizza in fase di modifica/
creazione delle pagine è effettivamente
identico a quanto si vede una volta che il
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genze degli autori: mentre editor più vec-
chi forzano le persone a “ pensare” al
codice, HyperPublish forza il codice a
“ pensare ipertestuale” . Questo significa
un cambiamento di mentalità per chi ad
esempio fosse già abituato a scrivere di-
rettamente l’HTML, ma alla fine rende le
cose molto più semplici, per tutti, non solo
per i principianti.

Grazie all ’ impostazione orientata al-
l’ ipertesto infatti, nella maggior parte dei
casi per effettuare un’operazione su un
intero insieme di pagine è suff iciente un
clic (serve un clic per archiviare un intero
ipertesto; pubblicare in Internet; fare ri-
cerche e sostituzioni globali ).

Se ancora non bastasse, HyperPublish
è in grado di convertire i propri documenti
in formato HTML Help e WinHelp, inte-
ragendo con gli appositi compilatori Mi-
crosoft.

In è definitiva uno strumento molto
potente per chi desidera avere la libertà di
pensare a quello che sta facendo, invece di
essere costretto a fare confusione con pro-
grammazione, file o codifica.

Il software funziona su qualsiasi PC
con MSWindows 95 osr2 o superiore.
Basta un Pentium 100 con 32MB RAM,
32MB di spazio libero sull ’HDD.

Crediamo che apprezzerete il nostro
sforzo. Buona lettura.

lavoro è pubblicato su Internet o CD.
HyperPublish è anche WYSIWYL (“ vedi
quanto colleghi” ), cioè tutti i collegamenti
tra le pagine possono essere definiti a
video - navigando in un’anteprima - e
diventano immediatamente “ attivi” , tanto
che si può seguirli già nell ’editor tramite
doppio clic. E’ più facile da vedere che da
spiegare.

L’editor è ottimizzato per agire su in-
siemi di pagine, piuttosto che su pagine
singole: anche l’archiviazione dei lavori
avviene in un solo file per ogni ipertesto,
in formato nativo (AEH), mentre HTML o
RTF sono visti per ciò che sono, niente
più che linguaggi di stampa che potranno
essere aggiornati in futuro senza la mi-
nima necessità di intervento da parte del-
l’utili zzatore.

Come già accennato, la pubblicazione
di CD autoinstallanti è molto semplice
perché il programma è in grado di creare
una “ bozza” del CD, da masterizzare di-
rettamente con un comune programma di
masterizzazione (EasyCD, Nero, ecc.). Si
può definire l’ immagine di installazione,
un file di li cenza e diverse interessanti
opzioni.

La pubblicazione Internet è gestita at-
traverso un motore FTP interno (FTP è lo
standard più comune per la pubblicazione
Internet) che è in grado di pubblicare un
intero sito in un solo passo, distinguendo e
trasferendo automaticamente solo le pa-
gine modificate.

HyperPublish è molto differente da un
“ editor HTML” : non si tratta di uno stru-
mento pensato per editare codice (anche
se, volendo, è possibile aggiungere co-
dice). L’ interfaccia di HyperPublish è
stata progettata per coprire le nuove esi-
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giando i tasti. Si noti che nella casella in
basso al centro compare il numero “ 0” che
indica che siamo appunto nella pagina
n°0.

A questo punto selezioniamo la parola
“ patate” (saremo nella condizione in
Fig.2.), e premiamo il pulsante a forma di
“ foglio con la catena”, insomma questo
qui:

Apparirà la finestra in Fig.3. Questa
finestra è una delle più importanti di Hy-
perPublish, perché permette di definire un
gran numero di collegamenti, semplice-
mente scegliendo una delle linguette in
alto.

Per ora non dilunghiamoci: scegliamo
piuttosto la linguetta “ Nuova pagina”
(l’ultima a destra) e premiamo il pulsante
OK.

HyperPublish definirà il collegamento,
e contemporaneamente ci farà entrare
nella nuova pagina, in cui parleremo delle
patate. Guardando in basso al centro note-

5 inalmente siamo riusciti ad instal-
lare HyperPublish dal CD o dalla distri-
buzione Internet. Non vediamo l’ora di
iniziare a costruire le nostre pagine.

La prima cosa da tenere ben presente è
che HyperPublish opera su ipertesti, e non
su pagine. Questo vuol dire che in memo-
ria possono essere “ caricate” più di una
pagina per volta. È sempre possibile sfo-
gliare le pagine, creare collegamenti tra
una pagina e l’altra, navigare, fare ricer-
che. Il modo più facile per passare da una
pagina all ’altra è usare CTRL+ e CTRL-.

Inserire collegamenti
Collegare due pagine è una delle

azioni più semplici. Vediamo subito un
esempio in cui costruiamo un ipertesto
composto di due pagine collegate tra loro.

Lanciamo HyperPublish: comparirà la
finestra di Fig.1. Proviamo a scrivere
qualcosa nella pagina, semplicemente pi-
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precedente, la pagina 0, quella sulle ver-
dure.

Selezioniamo il testo “ Torna a pagina
precedente” , e premiamo nuovamente il
bottone con la catena. Comparirà la fine-
stra di Fig.5, che ci presenterà una lista di
tutte le pagine disponibili (nel nostro caso
la 0 e la 1): possiamo scegliere a video la
destinazione. Scegliamo quindi la pagina
“ Verdure” e premiamo OK.

HyperPublish ci porterà nella pagina
di Fig.6. Si noti che nella pagina è pre-

remo che la casell ina ora contiene il
numero “ 1” per indicarci che siamo a

pagina 1.
Scr i vi a-

mo ora un po’
di testo come
in Fig.4. A
questo punto
vorremmo in-
serire un col-
l egament o
all a pagina

Fig.1 -
HyperPublish alla

partenza: per
scrivere qualcos ���
sufficiente pigiare i

tasti...

Un collegamento iper-
testuale si presenta tipi-
camente come una pa-
rola o una scritta sottoli-
neata: “ciccando” sulla
scritta si passa a una
pagina collegata.

Fig.2 - Dopo aver
scritto qualcosa,

scegliamo una
parola, ad esempio

“patate”...
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sente il collegamento a “ patate” (la scritta
in blu, sottolineata). Se facciamo un dop-
pio clic sulla parola “ patate” , automatica-
mente l’editor ci porterà alla pagina
“ Patate” (cioè la pagina 1).

Da questa pagina possiamo fare clic
due volte su “ Torna alla pagina prece-
dente” per tornare indietro e così via.

Come si vede creare collegamenti e
navigare già nell ’editor è cosa molto sem-

plice e veloce.
Ci sono altri sistemi per passare da una

pagina all ’altra: si può scrivere il numero
della pagina nella casella indicata in pre-
cedenza, si possono usare le freccioline a
lato della casella, si può usare il tasto
destro del mouse sempre sopra la casella
(compare una lista delle pagine visitate
più recentemente). Inoltre è possibile
usare i bottoni rossi in alto a destra, per

Fig.3 - La finestra
che permette di de-
finire i collegamenti

pi � semplici: sce-
gliere l’ultima lin-

guetta

Fig.4 - Scriviamo
qualche cosa nella

pagina 1
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tornare alla pagina precedente o per pas-
sare alla successiva.

Usando “ Ipertesto >Sola lettura” si
può passare ad un’anteprima dell ’ iperte-
sto: è utile per vedere meglio visto che
elimina la necessità del doppio clic e na-
sconde le griglie che compaiono se si fa
uso di tabelle.

A questo punto è ora di salvare la

nostra opera. Ciò si ottiene con “ File
>Salva tutto” , che archivia tutto l’ iperte-
sto (1,2 o 1000 pagine; 1,2 o 1000 imma-
gini) in un singolo file con estensione
.AEH. Con questo sistema si ha compat-
tezza e semplicità nell ’ archiviazione e
nello scambio di lavori. Come si vedrà nei
prossimi capitoli , passare ad HTML o
altro è immediato.

Fig.5 - la videata in
cui si può scegliere

visualmente la
destinazione di un

collegamento...

Fig.6 - Siamo
ritornati alla pagina
0, dove possiamo

vedere che il
collegamento alla
pagina “patate” �

già attivo...
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parametri che sono forniti dal gestore del
server (Internet Provider, o altro). Si in-
troducono con “ Pubblica >Internet FTP
>Configurazioni...” : si veda a questo pro-
posito la Fig.7. Ovviamente non siamo in
grado in questa sede di conoscere i vostri
personali parametri che, lo ripetiamo, vi
devono essere forniti da chi offre il servi-
zio di pubblicazione (si veda anche il
manuale in linea “ ? >Help” con il rispet-
tivo tutorial passo passo).

Una volta completata la configura-
zione (e si tratta di un’operazione da ef-
fettuare solo per la prima pubblicazione,
in quanto il programma memorizzerà i
vostri parametri per ogni futura eve-
nienza) scegliete “ Pubblica >Internet FTP
>Pubblica ipertesto in rete...” . Comparirà
la finestra in Fig. 8. Una barra bianca e un
pulsante di “ stop” saranno visibili finché
HyperPublish non avrà controllato sul ser-
ver l’esistenza o meno di precedenti ver-
sioni del corrente ipertesto.

Se HyperPublish trova precedenti ver-
sioni, allora interviene un meccanismo au-

8l formato al momento più diffuso per
la realizzazione di siti Web è l’HTML.

Se consideriamo un insieme di pagine
Internet, una situazione molto comune è
che il computer che le rende disponibili al
mondo (detto anche “ server” ) sia fisica-
mente diverso e anche molto lontano dal
computer dell ’autore.

L’autore (ad esempio il signor Rossi
sul PC di casa) può inviare le sue pagine
Internet ad un server (per esempio il com-
puter dell ’uff icio) posizionato magari a
centinaia di chilometri di distanza: il si-
stema più usato per questo trasferimento è
FTP.

Pubblichiamo via FTP
Vediamo un semplice esempio in cui

pubblichiamo in Internet le pagine realiz-
zate nel capitolo precedente.

Innanzitutto occorre immettere la con-
figurazione del server FTP: si tratta di

!��2^\ � _dQQ[XRPa � bd
8]cTa]Tc



12

sistema è utile per pubblicare un ipertesto
a spezzoni, durante collegamenti succes-
sivi).

In ogni caso HyperPublish tiene trac-
cia con un sistema estremamente veloce di
quali pagine siano aggiornate o meno.

Completata la selezione (automatica o
manuale) tutto quello che resta da fare è
premere il pulsane “ Pubblica”: tutte le
pagine selezionate verranno pubblicate
senza altro sforzo. Alla fine dell ’opera-
zione HyperPublish visualizzerà un mes-

tomatico per cui solo le pagine effettiva-
mente modificate sono selezionate per la
pubblicazione.

Le pagine selezionate per la pubblica-
zione sono quelle che nell ’elenco a sini-
stra sono contrassegnate da una “ V” . E’
possibile selezionare manualmente even-
tuali pagine per cui si vuole forzare la
pubblicazione, oppure “ deselezionare”
pagine per cui invece si vuole rimandare
la pubblicazione (nel caso si disponga di
una connessione Internet volante, questo

Fig.7 - La pagina
con i parametri di

configurazione
dell’FTP...

Fig.8 - La finestra
per l’FTP: a sinistra
i file da pubblicare,

a destra i file
presenti sul server
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saggio di conferma ed il numero di ver-
sione dell ’ ipertesto presente su Internet.
Durante la pubblicazione è possibile de-
selezionare pagine o sospendere tutto.

Esportazione HTML
L’export HTML consente di salvare in

locale, cioè sul proprio HD, un file
HTML per ogni pagina del documento,
più un file per ciascuna immagine utili z-
zata.

Questa funzione si attiva usando “ File
>Esporta pagine...” oppure “ Pubblica

>Esporta pagine...” . Compare la finestra
di Fig.9, in cui è possibile scegliere quali
pagine esportare e quali no, sempre tra-
mite crocette. Tramite la linguetta “ Path”
(si veda la Fig.10) è possibile selezionare
la cartella dove saranno riversati i file
HTML risultato dell ’operazione. Sia per
quanto riguarda la pubblicazione FTP, sia
per quanto riguarda l’esportazione è inte-
ressante notare che HyperPublish genera
l' HTML solo “ alla bisogna”, mentre nor-
malmente usa il proprio formato nativo.

Nel mondo attuale dei software per
Internet questa è una stranezza (perché

Fig.9 - Finestra di
esportazione per tutti

i formati: in figur �	�
selezionato l'HTML...

Fig.10 - La linguetta
che permette di

definire il path per
l’esportazione

HTML...
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parecchi tecnici non si sono ancora abi-
tuati a pensare HTML come ad un puro
linguaggio di stampa, come ad esempio il
PostScript).

All ’atto pratico il sistema di HyperPu-
blish evita un sacco di preoccupazioni e di
disordine, e fa risparmiare tempo.

Anteprima in browser
Per quanto la visualizzazione che si ha

in HyperPublish sia molto fedele rispetto
alla visualizzazione sul browser (HP è
WYSIWYG, “ vedi quanto ottieni” , e ge-
nera automaticamente un codice ottimiz-
zato per ottenere i risultati migliori a par-
tire dai browser NS2 ed IE3) molti utenti
desiderano “ provare” direttamente nel
browser ogni pagina che realizzano.

Con HP è possibile farlo, utili zzando
“ Pubblica >Anteprima in browser” . E’
possibile vedere la pagina corrente nel
browser predefinito (di default), tutto l’ i-
pertesto nel browser di default, ed è anche
possibile definire delle voci di menù per il
richiamo rapido di altri browser.

Per definire dei richiami rapidi si usa
“ Strumenti >Opzioni del programma
>Browser” . La finestra che compare,

Fig.11, è molto facile ed intuitiva.

Profili FTP
Un’esigenza molto comune quando si

pubblicano pagine su più siti Internet tra-
mite FTP è la memorizzazione di diverse
configurazioni o profili . In HyperPublish
questo è possibile usando “ Pubblica
>Internet FTP >Configurazioni” . Nella
finestra riportata in Fig.7 è suff iciente
usare il pulsante “ Aggiungi nuova...” vi-
cino a “ Configurazione server” per intro-
durre un nuovo profilo utente.

Informazioni tecniche
Eseguendo gli esempi appena riportati

gli esperti avranno già notato che nell ’edi-
tor ci si riferisce alle pagine usando il
titolo della pagina (nome di alto livello),
piuttosto che il “ nome del file” (nome di
basso livello). Avranno anche visto che i
nomi dei file sono generati in modo fisso
ed automatico da HyperPublish, seguendo
un criterio di ottimizzazione che permette
di ridurre il trasferimento file quando si
pubblica via FTP.

Le convenzioni di Internet vogliono

Fig.11 - Definizione
delle scorciatoie

per avviare browser
alternativi al

browser di default...
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che la pagina principale (home page) di
un sito e in generale la pagina fondamen-
tale di un insieme prenda nome index.htm
o index.html. Per fare questo in HyperPu-
blish, o eventualmente scegliere un altro
nome, è suff iciente scegliere “ Ipertesto
>Proprietà dell ’ ipertesto corrente” , sce-
gliere la linguetta “ Impostazioni di pa-
gina, sfondo” , e usare la casella “ nome
file copertina (HTML)” .

Se serve, è possibile specificare un
nome di file anche per altre pagine (ad
esempio si può chiamare patate.html la
pagina delle patate), con “ Formato
>Proprietà pagina...” : HP crea automati-
camente il file indicato in modo da avere
una redirezione alla pagina corretta. Si
veda la Fig.12.

Si ricordi che per usufruire di tutte
queste possibilit à è necessario archiviare
i documenti nel formato nativo, l’AEH.

Creare Help di Windows o
HTMLHelp

HyperPublish ha la possibilità di
esportare anche in RTF per WinHelp,
cioè nel formato della “ Guida di Win-
dows” .

Per trasformare un intero ipertesto  in
un Help di Windows, in un colpo solo,
occorre semplicemente usare “ File
>Esporta pagine...” , e scegliere nella ca-
sella in alto il formato “ RTF WinHelp” .
HP genererà un sorgente RTF, quindi
chiamerà anche il compilatore MS Help
Project Compiler, HPC: è suff iciente defi-
nire il path del compilatore in “ File
>Esporta pagine... >Opzioni” . Si noti che
a causa delle caratteristiche del formato
alcune funzionalità permesse da Hyper-
Publish non possono essere riversate in
formato WinHelp (ad esempio le cornici o
frames).

Si può poi anche esportare in
HTMLHelp (.chm) cioè nel nuovo for-
mato della guida di Windows, disponibile
a partire dalla seconda versione di Win-
dows95. E’ necessario installare sulla
propria macchina l’ HTML Help
Workshop di Microsoft, disponibile libe-
ramente su diversi siti come vol-
ftp.mondadori.com. Anche in questo caso
per esportare basta selezionare “ Pubblica
>Esporta pagine...” e scegliere come for-
mato HTMLHelp.

E’ importante notare che un HTML
Help è visibile solo sulle macchine dove è

Fig.12 - La finestra
di proprietà pagina:
nella casella grigia

a sinistr ���
possibile inserire

un nome HTML per
la pagina...
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installato Internet Explorer (vedere il ns.
sito per altre informazioni).

Sia per WinHelp che per HTMLHelp
è possibile creare per l’ ipertesto un indice
ad albero, definendo cioè capitoli e sotto-
capitoli. Questo si può fare usando
“ Ipertesto >Ordine predefinito pagine -
TOC” .

In definitiva con HP lo stesso ipertesto
è disponibile senza alcuno sforzo sia in
HTML (ad es. per Internet), che in
WinHelp e HTMLHelp. Vedremo nel ca-
pitolo seguente che può inoltre essere di-
stribuito in formato nativo.

Importare WinHelp
Se si possiede l' RTF di un progetto

WinHelp realizzato in precedenza, esso
può essere importato in HyperPublish, per
realizzare modifiche ed ampliamenti,
sfruttando la capacità di HP di li berare
l' utente da ogni altro pensiero che non sia
il contenuto, e/o anche per effettuare un
passaggio al più completo mondo HTML.
L’ importazione si realizza tramite “ File
>Importa pagine...” , scegliendo come
prima il formato “ RTF WinHelp” .

Esistono sul mercato “ decompilatori”
per ottenere questo RTF da un comune
file .HLP.

Fig.13 - La finestra
di esportazione

RTF  WinHelp. E’
possibile anche

esportare in
normale RTF (ad

esempio per
leggere i file con

Word)

Fig.14 - Opzioni per
l’esportazione RTF
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es_aeh (in caso di installazione standard
è in c:\vv\cdroms\client\f). Trovato
es_aeh la finestra sarà così come in
Fig.22.

A questo punto occorre “ prendere” gli
ipertesti sulla sinistra e trascinarli nella
finestra a destra. Alla fine risulterà come
in Fig.23

Fatto questo, premete la linguetta
“ Path immagine del CD” (Fig.24), e sce-
gliete una directory dove salvare la prova
di Cd che stiamo per ottenere. Ad esempio
c:\temp.

Rimane solo la linguetta “ Personaliz-
zazione” . In Fig.25 possiamo vedere la
prima delle due sotto-linguette in cui si
divide.

Come si vede è possibile personaliz-
zare lo “ splash screen” del lettore
(sarebbe la classica finestra “ about” e la
finestra che appare quando si lancia il
programma). L’ immagine si introduce
premendo il bottone immagine. C’è un
semplice esempio in ..\es_CD\ wizStuff\
ssplash.gif.

Dna delle caratteristiche più in-
teressanti di HyperPublish è il Wizard
che facilit a la pubblicazione di un iperte-
sto (o di un gruppo di ipertesti) su CD:
usandolo è veramente semplice realizzare
un CD autoinstallante. Dentro al CD Hy-
perPublish inserisce un proprio lettore (o
“ browser” ) proprietario, iPerReader.
Questo fa sì che il CD risultante funzioni
sempre, indipendentemente dalla presenza
di Netscape o Internet Explorer sul PC del
lettore; inoltre iPerReader contiene un
motore di ricerca full -text, che permette
anche ricerche booleane (con operatori
e/o) all ’ interno di ogni ipertesto.

Per capire come si procede nel con-
creto, vediamo un esempio. Nell ’esempio
useremo uno degli i pertesti che costitui-
scono il manuale online di HP.

Scegliamo innanzitutto “ Pubblica >Cd
Rom” . Appare la finestra di Fig.21. Nel
file system a sinistra, navighiamo tra i
drive finché non troviamo la directory

"��2^\ 
 _dQQ[XRPa 
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fa nessuna modifica il programma intro-
duce dei file di default.

Appena definiti questi file, per creare
il CD basta premere “ Crea” . Il pro-
gramma creerà una bozza del CD nella
cartella precedentemente selezionata, e
chiederà se si desidera salvare le imposta-
zioni, in un file .wzz (es. prova.wzz). Se
occorre rifare il CD basterà caricare que-
sto file e procedere con eventuali modifi-
che.

Non appena HyperPublish ha finito di
creare il CD, apparirà un pulsante “ Test”
che si può premere per provare la proce-

È possibile definire il nome per il
gruppo Windows sotto il quale il nostro
ipertesto verrà installato nel menù avvio,
e poi è possibile introdurre il nome dell ’ i-
pertesto principale, quello che verrà mo-
strato non appena l’utente dà il primo
"run" dopo aver installato il CD. Nell ’e-
sempio c’ è indexHP.aeh che per l’ap-
punto è l’ indice dell ' Help.

Rimane ancora la linguetta di Fig.26
dove è possibile inserire file di li cenza,
benvenuto, commiato.

E’ possibile trovare esempi di questi
file sempre in es_CD\wizStuff\. Se non si

Fig.21 - La prima
finestra del Wizard

di creazione CD

Fig.22 - Cerchiamo
la directory es_aeh

usando l'Explorer
sulla sinistra
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Fig.23 - L’elenco
completo degli

ipertesti da inclu-
dere nel CD di

esempi � � sulla
destra...

Fig.24 - Il path
dove verranno

preparati i file da
riversare nella root
del CD-ROM, con

un comune pro-
gramma di maste-

rizzazione

Fig.25 - La finestra
che permette di

definire le proprietà
del lettore (gruppo di
Windows, immagine

all’apertura,...)
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dura di installazione, così come la vedrà
l’utente.

A questo punto guardando la directory
c:\temp si avrà quanto in Fig.27. Questo è
quanto si deve copiare nella directory root
di un CD. Se l’autoesecuzione è abilit ata
nelle impostazioni di Windows, il CD
risultante “ partirà” da solo all’ inseri-
mento nel lettore.

Non occorre altro.
Nel capitolo 9 gli utili zzatori esperti

possono vedere come  inserire programmi
sul CD ROM e lanciarli direttamente dal
CD; come lanciare dal CD file gestiti da
altre applicazioni, e infine come fare col-
legamenti ad ipertesti residenti su CD-
ROM.

Se si creano CD di grosse dimensioni
infatti una delle possibili scelte è di non

riversare su Hard Disk l’ intero contenuto
del CD (evitando così sovraffollamento
dell ’Hard Disk) e di chiedere invece al-
l’utente di tenere il CD nel CD drive
durante la consultazione della vostra
opera.

Se ci si limita ad usare il Wizard,
senza altri accorgimenti, esso predispone
tutti gli i pertesti inclusi sul CD al riversa-
mento sull ’Hard Disk. Usando un sem-
plice accorgimento è possibile invece cre-
are un ipertesto di “ copertina” (l’unico
ipertesto da includere nel Wizard, l’unico
ipertesto che sarà quindi copiato sull ’hard
disk) realizzandolo in modo che includa
semplici collegamenti ad uno o più iperte-
sti residenti su CD. Maggiori informa-
zioni su questo accorgimento sono per
l’appunto al Cap.9.

Fig.26 - Opzioni per
il setup del lettore:��� � ssibile

introdurre una
licenza per

l’utilizzatore del
vostro ipertesto, un

messaggio di
benvenuto, ecc...

Fig.27 -  File e
directory da

masterizzare per
ottenere un CD
autoinstallante
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di impostazioni relative al paragrafo ed al
carattere usato nel paragrafo. In generale
gli stili possono essere definiti e/o appli -
cati ad una porzione di testo tramite la
toolbar "Paragrafi", o il menù "Formato".

Il modo più veloce di capire i vantaggi
è considerare questo stesso testo.

Ogni singola pagina ha un titolo, que-
sto titolo ha lo stesso stile in tutte le
pagine, lo stile usato per il tit olo è diverso
da quello usato per il testo: il titolo è più
grande, ed usa un carattere diverso. Me-
morizzare uno stile per i titoli ed (almeno)
uno stile per il testo serve a due cose:

− velocizzare l'applicazione ad un pa-
ragrafo di una serie di attributi (se in
questa pagina non avessimo usato lo
stile "Titolo" per il tit olo, avremmo
dovuto selezionare tutto il tit olo, ap-
plicare il font, applicare il grassetto,
applicare la dimensione carattere,
applicare il colore)

− rendere possibile la modifica istanta-
nea di molte pagine modificando solo
una cosa (se vogliamo il tit olo verde

E isti i sistemi più semplici per
gestire pagine e collegamenti, passiamo
ad esaminare le principali funzioni rela-
tive al testo ed i principali oggetti che si
possono inserire.

Il formato del testo
E’ convenzione consolidata per tutti i

wordprocessor la possibilit à di applicare
grassetto e italico mediante appositi pul-
santi (le relative icone sono simili dapper-
tutto). Si può inoltre cambiare il colore e
la dimensione delle scritte, ed anche il
carattere o “ font” . Oltre a queste funzioni,
disponibili nella toolbar, HP aggiunge la
possibilit à di definire “ stili ” di testo, ana-
logamente a MS Word, Word Perfect ed
altri wordprocessor.

Gli stili
Gli stili del testo servono per memo-

rizzare e riutili zzare più volte un insieme

#��; 
 Ud]iX^]X
_aX]RX_P[X



22

stra in Fig.30 dove si possono definire
tutti i parametri dello stile.

Per applicare uno stile ad un paragrafo
o un blocco di testo, si fa clic sulla casella
di elenco stili . In una pagina come la
presente ad esempio compaiono gli stili:
Elenco, Testo, Titolo. Facendo clic su uno
degli stili elencati, i paragrafi selezionati
sono riformattati applicando lo stile.

Un altro modo per applicare uno stile
è selezionare un blocco, scrivere il nome
di uno stile esistente e premere Invio.

Per fare cambiamenti ad uno stile  si
cambiano gli attributi di testo ad una pa-
rola o a un paragrafo, si seleziona l'og-
getto del cambiamento, si entra nella ca-
sella elenco stil i della "toolbar", e si
preme Invio. Appare una finestra, dove si
deve scegliere "Modificare lo stile usando
come esempio il testo selezionato".

Un sistema alternativo è usare
“ Formato >Stili ...” , quindi scegliere uno
stile ed applicare il cambiamento.

La prima volta che si applica uno stile
ad un paragrafo alcuni attributi del testo
vengono conservati (italico, grassetto,
cambi di dimensione e font). Se si vo-

anziché nero, basta modificare lo
stile "Titolo", e in tutte le pagine di
questo testo il tit olo apparirà verde).

Ci sono molti modi per operare con gli
stili . Il modo più semplice per creare un
nuovo stile consiste nel modificare una
porzione di testo secondo gli attributi che
si vogliono applicare allo stile. Ad esem-
pio evidenziamo una parola, poi appli -

chiamo il
grassetto, poi
assegni amo
15 come di-
mensione. A
questo punto
scriviamo un
nome di stile
nella casella
di elenco stili
p r e s e n t e
n e l l a
"toolbar", e

premiamo Invio. Appare una finestra dove
è possibile confermare i parametri dello
stile.

In alternativa si può scegliere
"Formato >Nuovo stile": appare la fine-

Fig.30 - La finestra
in cui ��� � ssibile
definire un nuovo
stile o  modificare

uno stile esistente.
Usando “Importa”

si  può copiare uno
stile da un altro

ipertesto

Prima di iniziare un
nuovo lavor � ����� ��� �
regola spendere qual-
che minuto per definire
gli stili che si andrà ad
utilizzare. Usare gli stili
subito significa avvan-
taggiarsi nel caso di
successive modifiche.
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Collegamenti
Ora vedremo qualche tipo di collega-

mento in più rispetto a quelli esaminati
nel capitolo 1. Per fare un collegamento,
si è già detto che basta selezionare un
blocco di testo, e premere il pulsantino
con la catena (oppure "Inserisci
>Collegamento").

Nella pagina che appare, a seconda
della linguetta che si sceglie ci si può
collegare a:

− altre pagine dell 'ipertesto (funzione
vista nel Cap.1)

− altri ipertesti: la finestra è come
quella di Fig.31: si può scegliere un
altro ipertesto, e la pagina cui ci si
vuole collegare: il software presenta
a video l’anteprima della pagina, in
cui si può navigare per scegliere la
pagina di destinazione del collega-
mento

− un indirizzo in Internet: HyperPu-
blish mantiene una rubrica degli in-
dirizzi cui ci si è già riferiti nel

gliono eliminare, uno dei modi è scegliere
"Formato >Riformatta".

L’ uso degli “ stili” è cosa relativa-
mente recente nelle applicazioni di scrit-
tura e di desktop publishing. Le applica-
zioni più diffuse operano la seguente di-
stinzione fra stile e formattazione:

− “ Stile” significa tutti quegli attributi
di carattere definiti nello stile appli -
cato al paragrafo.

− “ Formattazione” significa gli stessi
attributi applicati ad un paragrafo,
ma andando ad applicarli diretta-
mente con i pulsantini o con
“ Formato >Carattere”

Possono esserci due paragrafi che ri-
sultano "uguali " a video, ma che "sotto"
sono costruiti diversamente. HP ovvia-
mente non può non considerare questa
diversità (come fanno altre applicazioni
quali MSWord del resto) perché gli utili z-
zatori "coscienti" degli stili si aspettano
che lo faccia.

Fig.31 - La finestra
in cui ��� � ssibile

stabilire un
collegamento con
una pagina di un

altro ipertesto. La
situazione pi �
semplice si ha

quando il file
relativo all’ipertesto� ��� lla stessa

directory.
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system. Quando l’utente fa clic su un
collegamento si vede il file; se questo
tipo di file non è mai stato visualiz-
zato, HP chiede istruzioni; Nel caso
di file molto grandi, sia per Internet
che per i CD è meglio lasciarli all ’e-
sterno. Per Internet si possono trasfe-
rire sul sito con un programma di
FTP, quindi si può piazzare un link
come ad esempio http://tuosito.com/

corrente ipertesto. Come si vede in
Fig.32 si può scegliere di collegarsi
ad uno degli i ndirizzi in rubrica, op-
pure si può aggiungere un nuovo
indirizzo premendo il pulsante “ +” ;

− un file incorporato: è possibile inclu-
dere all ’ interno di un ipertesto HP (e
quindi nel file AEH) un file di testo,
un file ZIP. Tramite la finestra di
Fig.33  si può cercare il file nel file

Fig.32 - Per inserire
un collegamento

verso un qualsiasi
indirizzo Internet,

oppure per inserire
un indirizzo email

si usa questa
finestra,

raggiungibile con
“Inserisci

>Collegamento”

Fig.33 - La finestra
che permette di

allegare
all’ipertesto un file

qualsiasi,
raggiungibile con

“Inserisci
>Collegamento”
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Immagini
Per introdurre un'immagine si usa il

pulsantino della toolbar, oppure “ Inserisci
>Immagine/Mappa”.

Compare la finestra di Fig.35 in cui è
possibile scegliere se inserire un’ imma-
gine presente su disco, se riutilizzare
un’ immagine già presente nell ’ ipertesto
traendola dall ’album interno, se prendere
un’ immagine da un altro ipertesto.

Si noti che per accedere alla raccolta
interna di clipart è necessario scegliere
“ Da disco” e premere il pulsante
“ Clipart” (l’ icona è una montagna con il
sole).

Una volta che un’ immagine è stata
inserita tra le altre cose si può:

− assegnare un collegamento all ’ im-
magine: con il tasto destro del mouse
"Definisci collegamento". Com-
paiono le stesse finestre disponibili
per i collegamenti di testo, ill ustrate
nei paragrafi precedenti. Per i colle-
gamenti speciali si veda nel seguito.

− definire una o più zone cliccabili
tramite il menù che compare col ta-

file.zip. Per i CD si possono usare le
funzioni pensate per lanciare file/
programmi, ill ustrate nel Cap.9.

− pagina da modello: è possibile colle-
garsi ad una nuova pagina, ottenuta
al volo copiando uno dei numerosi
modelli (Fig.34)

− una pagina ottenuta copiandone
un’altra: è possibile collegarsi ad
una nuova pagina ottenuta copiando
una delle pagine all ’ interno del cor-
rente ipertesto

− una pagina ottenuta copiandone
un’altra da un ipertesto qualsiasi

− una nuova pagina: questo è il colle-
gamento più semplice: andiamo a
collegarci ad una nuova pagina
vuota. Potremo in seguito inserire
qualcosa nella pagina.

È possibile anche usare le immagini e
introdurre zone “ cliccabili ” per inserire
collegamenti, lo vedremo in un successivo
paragrafo.

Gli esperti potranno approfittare anche
della potenza dei collegamenti speciali .

Fig.34 - Con questa
finestr ����� � ssibile

collegarsi ad una
nuova pagina

creata copiando
una pagina modello
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ogni immagine si possono definire molte
proprietà, accessibili i n ogni momento con
il tasto destro del mouse, o con
“ Immagine >Proprietà”. La finestra che
compare è ill ustrata in Fig.37-40 con tutte
le linguette disponibili. Segnaliamo la
possibilit à di rendere trasparente l’ imma-
gine, di renderla sensibile al mouse, di
allargarla o restringerla. Si può anche
intervenire a livello di codice HTML (Fig.
40).

Si possono inserire immagini che cam-
biano al passaggio del cursore, cioè sono
diverse se il cursore è sopra all ’ immagine
o meno: (Fig.38):  queste immagini pos-

sto destro del mouse “ Aggiungi
zona” , “ Cancella zona” (vedi
Fig.36). Le zone si possono spostare,
allargare; si può definire un collega-
mento per ogni zona sempre col tasto

destro del
mouse, op-
pure tra-
mite il
m e n ù
“ immagine
” o ancora
tramite la
toolbar.

P e r

Fig.35 - Tramite
“Inserisci

>Immagine” �
possibile inserire

immagini
prendendole da

disco o dall’album
interno

Fig.36 -
Inserimento di una

zona cliccabile (hot
spot) all’interno di

un’immagine

Un browser (lett.
“sfogliatore”) ��� � pro-
gramma che serve per
sfogliare pagine Inter-
net. I pi ��� iffusi sono
Netscape Navigator e
Microsoft Explorer
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Fig.37 - La finestra
di proprietà

immagine permette
di definire un testo

alternativo per
l’immagine, e molti

altri parametri

Fig.38 - E’ possibile
scegliere

un’immagine che
sostituisce la

presente quando il
cursor � � sopra di

essa

Fig.39 - Tramite
questa finestr ���

possibile sostituire
un’immagine dentro

tutto l’ipertesto, in
un colpo solo
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dal sistema WWW, le tabelle con bordi
trasparenti sono il modo più corretto per
posizionare oggetti sul video.

 I browser Internet più recenti  consen-
tono anche il posizionamento assoluto de-
gli oggetti sul video: tuttavia è meglio
evitare di utili zzare questo sistema, sia
perché rende le pagine impossibili da ve-
dere su browser poco recenti, palmtop, tv
box, sia perché rende la visualizzazione
dipendente dalla risoluzione del video: chi
ha un monitor più piccolo o più grande del
vostro potrebbe insomma trovare la pa-
gina scomoda da vedere, e di conseguenza
passare ad un altro sito.

Usando “ Inserisci >Tabella” compare

sono essere anche  collegate ad una pa-
gina.

Inoltre è possibile sostituire un’ imma-
gine con un’altra e fare in modo che la
sostituzione si propaghi automaticamente
a tutto l’ ipertesto (Fig.39). Per agire glo-
balmente sulle immagini a livello di iper-
testo è anche utile la finestra “ Album”
che compare con “ Ipertesto >Album im-
magini e cancellazioni” .

Le tabelle
Le tabelle non sono solo uno strumento

per incolonnare numeri e lettere.
Nell ' impaginazione su video proposta

Fig.40 - Gli esperti
possono

aggiungere codice
HTML all’interno

del tag <IMG>

Fig.41 - La finestra
di inserzione

tabelle
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mente sul layout della tabella, ad esempio
aggiungere/eliminare righe o colonne,
modificare lo sfondo di una casella, ecc.
è possibile usare il menù “ Tabella” op-

la finestra di Fig. 41 in cui è possibile
scegliere tra un certo numero di layout
predefiniti .

Se si desidera intervenire ulterior-

Fig.42 - Una tabella
appena inserita.

Trascinando i
rettangoli grigi si

possono
ridimensionare le

finestre

Fig.43 - Proprietà
della tabella

Fig.44 - Proprietà
della casella

selezionata, e della
colonna cui
appartiene
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sulla riga o sulla colonna.
E’ interessante notare che ciascuna

casella può avere come sfondo un’ imma-
gine o un colore, o essere “ trasparente” .
Inoltre le tabelle possono essere
“ annidate” , cioè si può costruire una ta-
bella dentro una casella di un’altra ta-
bella, e così via.

Per selezionare un’ intera tabella è
possibile usare il tasto destro del mouse e
“ Seleziona tabella”.

Per copiare una tabella basta selezio-
narla, premere CTRL+INS, posizionare il
cursore sulla destinazione e poi premere
SHIFT+INS.

pure i bottoni della toolbar (Fig. 42) che si
attiva quando il cursore è dentro la ta-
bella.

E’ inoltre possibile posizionare il cur-
sore su una casella ed utili zzare il tasto
destro del mouse.

Scegliendo “ Proprietà” compare la fi-
nestra di Fig.43 in cui è possibile definire
le proprietà della tabella, tra cui le dimen-
sioni dell ’eventuale bordo, la larghezza
fissa o in percentuale rispetto alla finestra
principale, lo sfondo che può anche essere
un’ immagine.

Usando la linguetta di Fig.44 è possi-
bile intervenire sullo sfondo della casella,
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Dn sistema molto usato per ren-
dere più fruibile o semplicemente più
bello un ipertesto è dividere lo schermo in
sezioni, dette “ cornici” o “ frame” .

HyperPublish offre diversi strumenti
per creare cornici, modificarle, copiare su
pagine diverse lo stesso layout di cornici.

Creare cornici
Per creare cornici è sufficiente ad

esempio trascinare e rilasciare una delle
barre zigrinate presenti ai lati dello scher-
mo.

Per prima cosa bisogna notare che Hy-
perPublish, nella maggior parte delle sue
finestre, continuerà a riferirsi alla pagina
con cornici come se fosse una pagina
singola: in particolare verrà sempre consi-
derata/visualizzata la pagina “ master”
dell ’ insieme di cornici, che è la pagina che
viene mostrata quando il bottone:

è rilasciato. Questo bottone serve

per passare dalla modalità di visualizza-
zione “ cornici” a quella “ nessuna cor-
nice” .  Usare il bottone non ha nessun
effetto sulla struttura effettiva della pa-
gina, è solo un’opzione di visualizzazione
dell ’editor. Questo pulsante è utile oltre
che per vedere il frame master di un in-
sieme cornici, anche per verificare il com-
portamento Internet dell ’ ipertesto nel caso
vogliate pensare anche a tutti quei
navigatori che dispongono di un
“ browser” che non supporta le cornici (es.
palmtop, tv box e similari).

Vediamo un esempio. Creiamo un
nuovo ipertesto con “ File >Nuovo iperte-
sto” . Trascinando la barra zigrinata a sini-
stra dividiamo la prima pagina (pagina 0)
in due sezioni (vedi Fig. 50). Possiamo
notare che la pagina “ master” è quella di
destra. Vogliamo usare la sezione di sini-
stra come indice, insomma vogliamo cre-
are una struttura per cui facendo clic a
sinistra su “ pagina A” a destra compare la
pagina A, facendo clic su “ pagina B” , a
destra compare la pagina B. Tutto questo

$��; � R^a]XRX�� � UaP\T�
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cornice di sinistra, premere il tasto destro
del mouse e selezionare “ Scegli pagina in
cornice...” . Compare la finestra in Fig.52.
A questo punto nel riquadro “ Pagina in
cornice” segniamo la voce “ scegli fra esi-
stenti” : la finestra cambierà come in
Fig.53, e potremo scegliere di inserire in

mentre la cornice a sinistra rimane immu-
tata.

Per fare questo creiamo una nuova
pagina “ File >Aggiungi nuova pagina”, e
all ’ interno di questa creiamo nuovamente
una cornice trascinando la barra (Fig.51).
Poi è necessario fare clic all ’ interno della

Fig.50 -
Trascinando la

barra da sinistra a
destra abbiamo

creato due cornici,
ed abbiamo iniziato
a scriverci dentro...

Fig.51 -
Riproduciamo lo
stesso layout di

cornici su una
nuova pagina

dell’ipertesto...

Fig.52 - Scegliamo
di mettere nella
cornice a sx la

stessa pagina che
era presente nel

precedente insieme
cornici...
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“ Inserisci >Collegamento” , comparirà
una finestra simile a quella di Fig.5 dove
è possibile scegliere “ Pagina B” come
destinazione. Allo stesso modo possiamo
procedere con “ Pagina A” .

Alla fine il tutto si presenterà come in
Fig.55: facendo clic a sinistra su “ Pagina
A” vedremo la pagina “ Pagina A” , facen-
do clic a sinistra su “ Pagina B” vedremo
la pagina “ B” .

Ci sono sistemi diversi per realizzare
un insieme cornici con le caratteristiche
indicate. In particolare qui il cambio pa-
gina è realizzato sostituendo entrambe le
cornici: dal momento che le due cornici di
sinistra sono di fatto la stessa cornice,
all ’utente “ sembra” che la sola pagina a
cambiare sia quella di destra. E’ possibile

cornice la pagina “ Indice” . In questo
modo la pagina “ Indice” sarà condivisa
tra i due insiemi di cornici. Si noti che
agendo sul riquadro “ dimensioni” è possi-
bile fare in modo che sia per la pagina
“ Pagina A” sia per la “ Pagina B” le
cornici di sinistra abbiano la stessa di-
mensione, per esempio il 25% dello
schermo.

Premendo OK si arriva alla Fig.54
dove possiamo inserire nella cornice di
destra il testo per la pagina “ B” .

Collegamenti
Rimangono solo da inserire i collega-

menti. Se evidenziamo il testo “ pagina B”
nella cornice di sinistra e scegliamo

Fig.53 - E’ possibile
inserire dentro una

cornice una
qualsiasi delle

pagine
dell’ipertesto...

Fig.54 -
Completiamo la

pagina scrivendo
“pagina B” nella

cornice a destra. A
questo punto

occorre solo pi �
aggiungere i
collegamenti
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Questo sistema è accessibile tramite
“ Formato >Gestione avanzata disposi-
zione cornici” . La finestra che si presenta
è quella in Fig.56: l’abbiamo richiamata
dalla pagina B.

Come si può vedere il l ayout della
pagina è ill ustrato a destra. Facendo clic
su una delle cornici, in basso appare l’an-
teprima della pagina contenuta nella cor-
nice, che si può eventualmente sostituite.

A sinistra compaiono tutti i parametri
della cornice selezionata (nome e caratte-

fare in modo che effettivamente sia solo la
cornice di destra a cambiare, e quella di
sinistra rimanga fissa.  Per fare questo è
necessario utili zzare i collegamenti spe-
ciali , che ill ustreremo nel seguito.

Copia di layout di cornici
esistenti

Vediamo ora un sistema comodo per
copiare layout di cornici, e per editare
layout esistenti.

Fig.55 - Il nostro
primo insieme di
cornici: facendo
clic sul m ��� ���

sinistra si sceglie la
pagina a destra

Fig.56 - Il layout
della pagina

corrente
visualizzato nella

finestra di gestione
avanzata: si noti

che si può
eliminare il bordo di

una cornice,
oppure la barra di

scorrimento
(scrolling)
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nuova pagina” (o l’apposito pulsante in
basso). Fatto questo scegliamo nella
nuova pagina “ Formato >Gestione avan-
zata disposizione cornici” .

Appare la finestra di Fig.57. Sce-
gliamo la linguetta “ Copia da altra pa-
gina” , e selezioniamo sulla sinistra
“ pagina A” (Fig. 58). A questo punto è
suff iciente premere il pulsante “ Copia an-
che cornici non master” così si copierà il
“ layout cornici” dalla pagina “ A” e anche
tutte le cornici non master (nel nostro caso

ristiche).
E’ possibile scegliere la linguetta

“ Copia da altra pagina” per sostituire il
layout corrente della pagina (potremmo
avere un insieme di cornici come in fi-
gura, o semplicemente una pagina sin-
gola) con il l ayout di una delle altre pa-
gine dell ’ ipertesto.

Ad esempio proviamo a creare la pa-
gina “ C” , identica ad “ A” e “ B” . Per
prima cosa occorre creare una nuova pa-
gina vuota, usando “ File >Aggiungi

Fig.57 - Se
richiamiamo la

gestione avanzata
da una pagina

vuota la finestra
compare così...

Fig.58 - Scegliamo
la linguetta “Copia”

e scegliamo una
delle pagine

esistenti
nell’ipertesto, per

copiarne il layout...
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Esiste inoltre la possibilit à di salvare il
corrente layout cornici come modello
(pulsante “ Salva” in Fig.56) e viceversa
di usare per la pagina corrente un modello
di layout predefinito. Per usare un mo-
dello si sceglie la linguetta “ Carica da
modello” (Fig. 61). Scelto il modello desi-
derato, occorre premere “ Copia Layout”
(si avrà una preview come in Fig.56), e
quindi OK, per tornare all ’editor ed otte-
nere la copia.

c’è una sola cornice non master, la cor-
nice “ indice” ). Premendo OK si è così
nella situazione di Fig.60, dove la cornice
sulla destra è la pagina master di “ Pagina
C” .

Come si può notare questo sistema è
particolarmente veloce per realizzare
menù laterali ed in genere riprodurre cor-
nici.

Sempre tramite la finestra di gestione
avanzata si può decidere che la cornice
master sia posizionata sulla sinistra o in
basso piuttosto che a destra.

Fig.60 - Abbiamo
copiato in una

pagina vuota lo
stesso layout della

pagina A e B: ora
possiamo scrivere

qualcosa nella
pagina (sezione

master, a
destra)...

Fig.61 - Per
velocizzare, �

possibile copiare
da uno dei modelli

predefiniti (e
anche salvare

nuovi modelli)...
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molte versioni di Netscape Navigator non
visualizzeranno queste cornici:  pertanto
sarebbe meglio evitarne l’utili zzo, o per-
lomeno fare in modo che il contenuto sia
ridondante rispetto al resto della pagina.
In altre parole i servizi/pagine accessibili
dalla cornice dovrebbero essere accessi-
bili anche dalla pagina principale, magari
tramite delle scritte in piccolo.

Cornici indipendenti
Usando "Inserisci >Cornice Indipen-

dente" si può inserire nella pagina una
cornice come in Fig.62. La finestra di
inserzione è quella che appare in Fig.63:
è possibile inserire all ’ interno della cor-
nice indipendente (o cornice volante)
qualsiasi pagina dell ’ ipertesto. Se si in-
tende sviluppare un ipertesto / sito / cata-
logo / manuale per il Web, si noti che

Fig.62 - Una pagina
che contiene una

cornice
indipendente

Fig.63 - La finestra
di inserzione

cornici
indipendenti. E’

possibile
richiamarla anche

usando il tasto
destro del mouse
su una cornice, e

“Proprietà”
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8moduli permettono all 'utente che na-
viga in Internet di inviare dati oltre che
riceverli .

In generale un modulo è composto da
una o più caselle da compilare, e da un
pulsante con cui lo si spedisce una volta
compilato. Ciascuna casella ha un proprio
identificatore.

In generale la pressione del pulsante
può attivare sul server un programma che
processa il modulo (questo programma è
definito spesso CGI, o script), oppure spe-
dire il modulo a un indirizzo email . In
HyperPublish inoltre il pulsante può atti-
vare un cambio di pagina.

Inserire moduli
Inseriamo una casella con l’apposito

pulsantino (o usando "Inserisci >Moduli
>Elemento di modulo"). Il programma ci
chiederà se intendiamo inserire un
"marcatore di inizio modulo" (Fig.71). È

indispensabile inserirlo, perché il marca-
tore determina il comportamento che si
avrà quando l’utente preme il bottone di
invio modulo.

Se non avete ancora deciso premete
semplicemente OK. In ogni momento è
possibile cambiare le caratteristiche di
questo marcatore, basta usare il tasto de-
stro del mouse e "Proprietà". Compare la
finestra di Fig.72: se volete spedire i dati
del vostro modulo per e-mail i nserite ad
esempio il vostro indirizzo di email .

Appare quindi la finestra di Fig.73
dove è possibile usare le linguette per
inserire vari tipi di modulo. In Fig.70
abbiamo inserito il più semplice.

Vediamo un modulo più complicato in
Fig.74. È possibile definire un modulo in
modo che la pressione di un bottone pro-
vochi un cambio pagina. Si noti che co-
munque questo non è un comportamento
standard e non funzionerà con tutti i brow-
ser.

Per fare questo è necessario innanzi-
tutto che il “ marcatore di inizio modulo”

%�� ��� ^Sd[X
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Fig.70 - Una pagina
con un semplice

modulo

Fig.71

Fig.72 -
Inserimento del

marcatore di inizio
modulo che

determina che fine
faranno i dati del

modulo

sia definito come in Fig.75. Poi per ogni
pulsante va definita la pagina destina-
zione del salto, come in Fig.76, sce-
gliendo la linguetta “ Avanzate” della fi-
nestra di proprietà bottone (O Inserisci
>Moduli >Bottone).

È possibile inserire più moduli nella
stessa pagina. Per far questo è suff iciente

inserire un marcatore di inizio modulo
ogni volta che si inizia un nuovo modulo.
Ognuno dei moduli può dare la destina-
zione che vuole ai dati immessi dall 'utente
nelle caselle che lo riguardano. I pulsanti
di invio dati possono essere dovunque
all 'interno dello spazio di ogni modulo.
Ogni bottone spedisce solo i dati perti-
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Fig.73 - Gli
elementi  disponibili

per costruire un
modulo

Fig.74 - Un modulo
un po’ pi �

completo...

Fig.75 - Un
marcatore di inizio

modulo
particolare...



41

Fig.76 - Qui
abbiamo scelto
una pagina da

raggiungere quando
l’utente preme il

bottone

nenti al modulo di appartenenza. Un
esempio pratico è visibile tramite “ ?
>Help” .

Per vivacizzare l’ambiente, può essere
simpatico inserire un’ immagine al posto
del bottone. In Fig.77 abbiamo un esem-
pio.

Per inserire questo tipo di bottone si
usa come sempre “ Inserisci >Moduli
>Bottone” (o l’ apposito pulsantino),
quindi “ Scegli immagine” .

A questo punto si sceglie l’ immagine
dall ’album fotografico interno o da disco
(come in Fig.35).

Gli utili zzatori esperti possono imple-
mentare funzioni non disponibili diretta-
mente in HyperPublish intervenendo sul
codice generato da HyperPublish. In par-
ticolare è possibile aggiungere comandi
dentro ai tag HTML che HyperPublish
genera.

Questo è possibile per i marcatori di
inizio modulo (tag FORM), per tutti gli
elementi (INPUT, SELECT; ecc., a se-
conda dell ’elemento), per i bottoni (tag
INPUT), ed è particolarmente utile in
unione all ’ inserimento di Javascript. La
finestra è simile a quella di Fig.40.

Fig.77 - Bottoni che
usano immagini
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Ã possibile inserire diversi oggetti
multimediali , tutti quelli il cui player è
installato correttamente in Windows. Ad
esempio:

− pagine con motivo in sottofondo
− pagine con pulsante che fa partire un

motivo
− pagine con video avi
− pagine con video mov

È possibile inserire anche oggetti
meno standard, che richiedono l’ inseri-
mento di parametri specifici Html:

− pagine con applet java
− pagine con oggetto + embed (oggetto

utilizzabile per essere compatibili
sia con NS che con IE)

Questi ultimi oggetti non saranno vi-
sualizzati direttamente in HyperPublish (e
neanche in iPer Reader, il l ettore automa-
ticamente inserito sui CD creati) ma solo
in un browser HTML, cioè solo dopo aver
esportato o pubbli cato l’ ipertesto in
HTML. Per inserire particolari file in un

CD è utile la funzione che permette di
lanciare programmi o file contenuti nel
CD: si veda a questo proposito il Cap. 9.

Suoni e video
Per inserire ad esempio un suono di

sottofondo si sceglie “ Inserisci
>Animazione - suono” . Compare la fine-
stra di Fig.80. Premendo il pulsante
“ scegli file” si passa alla finestra di
Fig.81, dove è possibile scegliere su disco
un file audio. Si possono usare file wav,
mid, e naturalmente tutti gli altri formati
supportati dalla vostra installazione di
Windows: se l’ ipertesto è pensato per la
pubblicazione Internet dovrete accertarvi
che siano anche supportati dai browser
(wav e mid lo sono pressoché nella tota-
lità dei casi). Se nel corrente ipertesto
sono già usati dei file audio, è possibile
selezionarli i n modo veloce, usando la
linguetta di Fig.82.

Per quanto riguarda le animazioni il
procedimento è esattamente identico e le

&��>VVTccX�\d[cX\TSXP[X�
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Fig.80 - Finestra da
usare per inserire

suoni o animazioni:
i corrispondenti file

dovranno già
essere pronti ed in

un formato
supportato dai

browser

Fig.81 - Qui �
possibile scegliere

da disco un file
sonoro o

un’animazione

finestre che compaiono sono le stesse. Ci
sarà da scegliere “ video” come tipo del
media.

Nel riquadro “ tipo di azione” si può
scegliere se si desidera un’azione ciclica
(es. suono di sottofondo, o animazione
che cicla continuamente), oppure la visua-
lizzazione di un blocco pulsanti con i
quali l ’utente, se lo desidera, potrà fare
partire il suono o l’animazione.

La casella “ cicli ” indica il numero di

cicli da effettuare nel caso si scelga un
suono di sottofondo o un’animazione ci-
clica. Scegliendo “ 1” è possibile ad esem-
pio inserire effetti sonori che vengano
eseguiti all’ entrata nella pagina (la
“ presentazione” di HyperPublish usa que-
sta possibilit à, ad esempio).

Applet
Per inserire un’applet si usa “ Inserisci

>Embed Java Active X” .
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Fig.82 - HP
mantiene un

comodo album dei
suoni/animazioni
già usati altrove

nell’ipertesto

Compare una finestra come in Fig.83.
Occorre inserire il codice HTML: la cosa
da notare è che per riferirsi a file o imma-
gini non si usa direttamente il nome di un
file o di un’ immagine, ma si usano i bot-
toni sulla destra. Premendo uno di questi
bottoni sarà possibile scegliere in modo
visuale l’ immagine o il file da inserire,
dopodiché HP inserirà un codice di riferi-
mento che sarà sostituito con il nome
effettivo del file o dell ’ immagine solo in

fase di esportazione HTML. Questo si-
stema è utile perché vi lascia liberi di
cambiare immagini o file a livello globale
di ipertesto, senza dover intervenire sul
codice: cosa ad esempio molto utile se più
applet fanno riferimento allo stesso file/
immagine.

Il comportamento dell ’applet sarà visi-
bile solo esportando in HTML, o pubbli -
cando tramite le estensioni server, oppure
utilizzando “ Pubblica >Anteprima in

Fig.83 - Quest �	�
la finestra che

permette di inserire
il codice relativo ad

un’applet. Il file
dell’applet (.class)

sarà archiviato
nello stesso album

già visto per i file
musicali
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browser” , magari dopo aver configurato
il browser con “ Pubblica >Anteprima in
browser >Opzioni” (si veda il Cap.2). Il
menù "Pubblica" è disponibile solo con
"Ipertesto >Sola lettura" disabilit ato.

Per comprendere meglio il meccani-
smo è utile vedere il fi le multime-
diaHP.aeh (uno dei file dell ’Help pre-
senti nella directory es_aeh). Uno degli
esempi riportati è particolarmente inte-
ressante perché non solo si utilizza
un’applet (messagera.class), ma uno dei

parametri dell a stessa è un file,
(untitled_messagera.vac). Utili zzando il
tasto destro del mouse si può vedere come
è stato costruito il codice che lancia la
applet. Si noti che i due file di cui sopra
sono inclusi nell ’ ipertesto e verranno ge-
nerati automaticamente quando si pub-
blica in Internet o si desidera un' ante-
prima.

Inserire un oggetto ActiveX o Embed
è semplice come inserire un’applet: si
introduce il codice ed al momento di in-

Fig.84 - Oggetti
ActiveX o Embed

possono essere
inseriti facilmente.
HP può gestirne a

video le dimensioni
(si notino i

marcatori X e Y)

Fig.85 -
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trodurre il file si usa il bottone “ Oggetto
fondamentale” che introdurrà nel codice
un riferimento al file (Fig.85) o ad una
pagina interna (Fig.86) o ad un indirizzo
Internet (Fig.87).

Inoltre è possibile inserire nel codice
un riferimento alle dimensioni dell ’applet
o dell ’embed/ocx, sempre usando i pul-
santi di destra: sarà in questo modo possi-
bile ridimensionare a video un rettangolo
che simula l’occupazione di spazio del-
l’oggetto. La fedele rappresentazione a

video dell ’oggetto si avrà solo usando
l’esportazione HTML e guardando il file
con un browser correttamente configu-
rato.

Intestazione e pie di pagina
Ogni pagina creata con HyperPublish

può avere o meno un’ intestazione e/o un
piè di pagina. La caratteristica particolare
di HyperPublish è che intestazione e piè
di pagina non sono oggetti speciali , ma

Fig.86 - E’ possibile
introdurre dentro al

codice un
riferimento

dinamico ad una
pagina interna

Fig.87 - E’ possibile
introdurre dentro al

codice un
riferimento

dinamico ad un link
generico



47

una qualsiasi pagina dell 'ipertesto può es-
sere usata come intestazione per un’altra
pagina.

Si possono distinguere:
− intestazione e/o piè di pagina globali

per tutto l’ ipertesto
− intestazioni e/o piè di pagina partico-

lari per una pagina o un gruppo di
pagine

− pagine senza intestazione/piè di pa-
gina, anche se è definita un’ intesta-
zione globale o un piè di pagina
globali

Per decidere di assegnare a tutto l’ i-
pertesto un’ intestazione e/o un piè di pa-

gina si sceglie “ Ipertesto >Proprietà del-
l’ ipertesto corrente >Impostazioni di pa-
gina” (Fig.94).

Le impostazioni decise in questa fine-
stra sono valide per tutte le pagine dove
non sia stata operata una precisa scelta
per il piè di pagina o l'intestazione. Al
limite ogni pagina dell ’ ipertesto può avere
la sua intestazione e/o piè di pagina pri-
vata, oppure nessuna intestazione e/o nes-
sun pie di pagina. Per decidere le imposta-
zioni di ciascuna pagina si sceglie
“ Formato >Intestazione e piè di pagina”
(Fig.95).

Fig.94 - Finestra in
cui si possono

definire
un’intestazione

e/o un pie di pagina
globale...

Fig.95 - Finestra in
cui si può decidere
pagina per pagina
se usare o meno

intestazione e pie
di pagina
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Fig.96 - Il modo pi �
semplice per dire

ad HP di sostituire
la pagina corrente

con quella indicata,
dopo N secondi

Fig.97 - In
questa finestra��� � ssibile

pianificare
facilmente una

sequenza di
diapositive

Diapositive
È possibile utilizzare "Inserisci

>Funzioni di pagina >Diapositive" per
imporre al programma di rimpiazzare la
pagina corrente con un’altra.

La finestra che compare è quella di
Fig.96. Per vedere un esempio funzio-
nante utilizzare “ ? >Mostra presenta-

zione” .
Scegliendo “ Ipertesto >Diapositive” è

anche disponibile la finestra di Fig.97 che
permette di pianificare una sequenza di
diapositive, scegliendo le pagine fra tutte
quelle disponibili nell ’ ipertesto e permet-
tendo di variarne l’ordine con “ drag &
drop” .
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?er sempli ficare l’apprendimento
al principiante, HyperPublish divide le
sue possibilit à di effettuare collegamenti
tra pagine in collegamenti “ normali ” e
“ speciali ” .

E’ consigliabile occuparsi dei collega-
menti “ speciali ” solo dopo che si è già in
confidenza con gli altri: il  numero di pos-
sibilit à che aprono è molto vasto, e va
quindi affrontato poco per volta.

Innanzitutto è possibile collegarsi ad
un’altra pagina, con queste modalità:

− la pagina apparirà come finestra se-
parata

− la pagina apparirà in un’altra istanza
del browser

− la pagina destinazione apparirà nella
cornice che ora è occupata dalla
chiamante

− la pagina destinazione apparirà in
un’altra cornice o altra finestra

− la pagina apparirà come popup
− tramite ancore

Sono poi disponibili queste azioni:
− facendo clic sul collegamento si

chiude una finestra
− facendo clic sul collegamento appa-

rirà la finestra di ricerca per parola
chiave

Inoltre ci si può collegare:
− all ’ interno pagina, tramite ancore
− alla pagina che precede un’ altra

nella “ sequenza” di WinHelp (<<)
− alla pagina che segue un’altra cor-

rente nella “ sequenza” di WinHelp
(tasto >>)

Tutte queste azioni sono “ visuali ” cioè
non è necessario fare nulla di diff icile,
tantomeno scrivere codice.

Gli esperti però troveranno utile anche
la possibilit à di intervento sul codice ge-
nerato per un collegamento (è suff iciente
scegliere la linguetta “ HTML” durante la
modifica delle proprietà di un collega-
mento).

Vedremo in seguito come manipolare
finestre in modo diretto, senza che l’uten-
te debba fare clic su un link.

'�� � R^[[TVP\T]cX

±b_TRXP[X²



50

Ancore
Il collegamento speciale più semplice

è il collegamento ad un’ancora nella stes-
sa pagina. Un collegamento del genere è
utile quando in una pagina molto lunga si
vuole offrire al lettore la possibilit à di
saltare velocemente da una parte all ’altra
della pagina stessa. L’ “ ancora” non è
nient’altro che un marcatore che segna un
punto della pagina a cui è possibile salta-
re.

Per inserire un’ancora si posiziona il
cursore nel punto desiderato e si sceglie
“ Inserisci >Ancora” . Ad esempio in
Fig.100 abbiamo inserito un’ancora da-
vanti al titolo “ La fine” .

Per inserire un salto ad un’ancora oc-
corre selezionare un blocco (o una zona in
un’ immagine) e scegliere “ Inserisci
>Collegamento speciale” (oppure
“ Immagine >Definisci collegamento spe-
ciale” ). Compare la finestra in Fig.101.

La linguetta di default (predefinita) è
quella che si riferisce all ’ancora. Come

richiesto dalla finestra, a questo punto
occorre premere OK. Verrà proposta la
finestra in Fig.102 che proporrà un’ante-
prima della pagina corrente, con eviden-
ziate tutte le ancore disponibili . Si tratterà
a questo punto semplicemente di scegliere
a quale ancora saltare. Le ancore sono
numerate: una volta scelta un’ancora un
doppio lampeggio della casella in basso
segnala che la selezione è avvenuta.

Se in seguito si volesse modificare la
scelta, bisogna posizionare il cursore so-
pra il collegamento, usare il tasto destro
del mouse e scegliere “ Proprietà del colle-
gamento” . La finestra che appare è molto
simile a quella di Fig.101, solo che per
modificare la pagina destinazione del col-
legamento è necessario premere il pul-
sante “ Definisci a video” (vedi Fig.103).

E’ possibile saltare ad un’ancora an-
che mentre si salta ad una pagina diversa
dalla corrente. Per fare questo si sele-
ziona un blocco e si sceglie come prima
“ Inserisci >Collegamento speciale” ,

Fig.100 - Una
pagina in cui �

inserita un’ancora
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Fig.101 - La
finestra di
inserzione

collegamenti
speciali

Fig.102 - La
finestra che
consente di

scegliere l’ancora
di destinazione

Fig.103 - Proprietà
del collegamento

appena inserito
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quindi si sceglie la seconda linguetta
(“ Normali ” , Fig.104) e al suo interno, nel
riquadro “ la pagina di destinazione ap-
pare” si sceglie “ Nella finestra corrente,
saltando ad un’ancora”. Premendo OK è
possibile scegliere una pagina di destina-
zione e un’ancora (Fig.105).

Fare apparire finestre
Se nella finestra di inserzione collega-

menti speciali si sceglie invece la terza
linguetta, è possibile far apparire la pagi-

na di destinazione dentro una finestra.
Come si può vedere dalla Fig.106 è indi-
spensabile definire un nome per la fine-
stra, perché questo nome potrà essere uti-
lizzato in seguito ad esempio per cam-
biare il contenuto della finestra.

Infatti se due collegamenti si riferisco-
no ad una finestra con lo stesso nome (ad
es. “ Pippo” ), e si fa clic prima sul collega-
mento 1, poi sul collegamento 2, l’effetto
che si ottiene non sarà quello di far appa-
rire due finestre, ma di rimpiazzare nella
finestra “ Pippo” la pagina di destinazione

Fig.104 - Altri
possibili

collegamenti

Fig.105 -
Scegliamo una

pagina di
destinazione del

collegamento, ed
un’ancora. La

finestra di
collegamento

permette anche
altri tipi di

collegamento.
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del collegamento 1 con la pagina di desti-
nazione del collegamento 2.

E’ possibile poi fare apparire popup,
che funzioneranno come tali solo nella
pubblicazione CDROM. Nel caso la pa-
gina selezionata come destinazione sia un
insieme di cornici, è possibile scegliere se
in finestra deve apparire tutto l’ insieme
oppure solo la pagina “ master” (Vedi
Cap.4 per le definizioni).

Scegliendo la linguetta di Fig.104 e la
voce “ in un’altra istanza del browser” , la
destinazione appare in un’altra istanza
del browser.

Scegliendo la quinta linguetta è possi-
bile chiudere una finestra, fornendo il suo
nome.

Collegamenti in insiemi di
cornici

Gli altri collegamenti disponibili sono
utili all ’ interno di un insieme di cornici.

Supponiamo di avere il layout di
Fig.107: vogliamo che facendo clic su

una delle parole nella cornice di destra, la
cornice di destra sia sostituita da un’altra
pagina. Vogliamo che la cornice di sini-
stra rimanga immutata. Per fare questo è
suff iciente scegliere “ nella finestra cor-
rente, al posto della pagina che contiene il
collegamento” , nella linguetta in Fig.104:
alla pressione di OK verrà richiesta come
al solito la pagina di destinazione.

Un’altra possibile scelta è usare la
linguetta di Fig.108: in essa è possibile
scegliere a video la cornice in cui appa-
rirà la destinazione del collegamento. Si
noti che è possibile introdurre manual-
mente il nome della cornice destinazione.
Questo è utile ad esempio per “ cornici
indipendenti” inserite all’ interno della
pagina (cfr.Cap.4), oppure per attivare
salti dentro cornici contenute in finestre
separate. Dovunque sia la finestra/cor-
nice con il nome selezionato, il suo conte-
nuto sarà rimpiazzato dalla pagina desti-
nazione non appena l’utente fa clic sul
collegamento.

Infine con l’ultima linguetta è possi-

Fig.106 - Altri tipi di
collegamenti

disponibili
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Fig.107 -  Un
semplice insieme

di cornici, usato
come esempio

Fig.108 - E’
possibile scegliere
a video la cornice
in cui apparirà la
destinazione del

collegamento, ci � �
la pagina che si

sceglie premendo
OK

Fig.109 - La
finestra di lancio/
chiusura finestre
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bile attivare alcuni “ salti ” speciali: saltare
alla pagina precedente o successiva di una
sequenza di pagine (è possibile definire
sequenze di pagine, valide anche per
WinHelp, nella finestra di Proprietà testo,
Fig.12).

Può essere interessante ricordare che
sia blocchi di testo che immagini e zone
cliccabili (Fig.36) possono approfittare di
tutti i collegamenti descritti .

Fare apparire finestre
E’ possibile fare apparire finestre

senza costringere l’utente a fare clic su un
collegamento: con “ Inserisci >Funzioni di
pagina >Lancia/chiudi finestre” si inseri-
sce all ’ interno di testo un “ blocchetto fun-

zionale” che si attiva non appena l’utente
“ entra” nella pagina che lo contiene.

Nelle proprietà del blocchetto
(Fig.109) è possibile definire le caratteri-
stiche della finestra da aprire, oppure for-
nire il nome della finestra da chiudere.

Per queste ultime funzioni, come in
generale per tutti i collegamenti speciali ,
è assai utile vedere la guida “ ? >Help”  (o
aprire direttamente i file in es_aeh) dove
sono mostrate tutte queste funzioni in
azione, e una serie di “ trucchetti” o me-
glio di idee per un impiego intelli gente di
queste risorse.
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8n HyperPublish è possibile inserire
codice HTML e Javascript. Vi riman-
diamo alla guida on-line per vedere me-
glio come, visto che questo non è certo un
argomento riservato al neofita.

Qui ricordiamo solo brevemente che le
opzioni sono due: è possibi le inserire
HTML o JS ad inizio pagina tramite
“Inserisci >Script Java/Vb >Ad inizio pa-
gina” (Fig.120) .

Per inserire HTML o JS dentro al nor-
male testo di una pagina si usa invece

“Inserisci >Script Java/VB >In mezzo al
testo” .

Per vedere il testo dello Javascript, e/o
modificarlo, usare il tasto destro del mouse
sull 'icona a forma di pagina che compare a
marcare il punto dell ’ inserzione, e sce-
gliere “Proprietà” (Fig.121).  Si noti che le
finestre che nel programma permettono
l’ inserzione di codice sono tutte simili: si
possono usare dei modelli con i pulsanti
“Carica” e “Salva”, si possono inserire in
modo visuale riferimenti ad oggetti interni
all ’ ipertesto (immagini, pagine, fi le)
usando i bottoni sulla destra.

(��5d]iX^]X�PeP]iPcT

Fig. 120 -
inserimento di

Javascript HTML
all’interno del tag

<HEAD>
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Fig. 121 -
Proprietà di uno

script appena
inserito

HTML aggiunto a immagini,
moduli, oggetti

In HyperPublish è possibile aggiun-
gere HTML ad ogni oggetto: è suff iciente
far apparire la finestra di proprietà og-
getto usando il tasto destro del mouse e
scegliendo “ Proprietà”. Nella finestra che
appare si deve scegliere la linguetta
“ HTML” . Ad esempio in Fig.122 ve-
diamo l'HTML aggiunto ad un box di
testo in uno degli esempi Javascript rag-
giungibili con “ ? >Esempi” .

Ipertesti su CD
Il Wizard di installazione di HP

(”Pubblica >CDROM”) prepara un CD
con un programma automatico di installa-
zione. Questo programma trasferisce sul-
l’Hard Disk della persona che vuole leg-
gere l’ ipertesto un programma di lettura
(iPerReader) e tutti i  file .AEH che for-
mano l’ ipertesto, o almeno tutti quelli
indicati nel Wizard. A volte può essere
utile lasciare su CD alcuni file AEH, ad
esempio perché sono grandi e si preferisce
che l’utente li consulti direttamente dal

Fig. 122- HTML
aggiunto ad un

modulo
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CD. Ovviamente questa ultima scelta im-
plica che l’utente mantenga il vostro CD
nel drive durante la consultazione del vo-
stro lavoro.

Per lasciare alcuni ipertesti sul CD,
creare una directory sul CD (se ne può
ovviamente preparare una bozza sul-
l’HD), chiamandola per esempio
“ prova” , e inserendoci dentro gli i pertesti
che vogliamo rimangano sul CD, per
esempio “ prova1.aeh” , “ prova2.aeh” ,
ecc.

A questo punto per richiamare una
pagina di questi ipertesti da un altro iper-
testo (uno di quelli che andranno sull ’HD)
è sufficiente usare “ Inserisci
>Collegamento” , scegliere la linguetta
“ Pagina di altro ipertesto...” e scrivere

nella casella indicata in Fig.123.
Volendo si può usare anche la terza

linguetta, come indicato nella figura 125.
In ogni caso la sintassi per collegarsi

ad esempio alla pagina 34 dell ’ ipertesto
pippo.aeh inserito nella directory pluto del
CD è:

iper://cddrive:\pluto\pippo.aeh|34
La scritta cddrive: è solo un modo per

far sapere ad HyperPublish che deve inse-
rire automaticamente il nome del drive
CD.

Siccome un esempio pratico vale più
di mill e parole, nella confezione di Hyper-
Publish è presente un CD realizzato con
questa tecnica, il CD della mostra d’arte
Eikon, realizzata con il patrocinio della
Provincia di Biella (per gentile conces-

Fig. 123-
Collegamento

ad ipertesto su
CD

Fig. 124- Nel
CD “Eikon”,

l’unico ipertesto
incluso nella

lista del Wizard� � ikon.aeh, un
file di una

pagina sola che
fa da copertina
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sione dei curatori della mostra e di Do-
mino srl che lo ha realizzato).

Il CD contiene solamente due ipertesti:
eikon.aeh e anticheiconerusse.aeh. Il
primo è un ipertesto che consta di un’u-
nica pagina, un ipertesto che funge da
copertina. Il secondo è il catalogo vero e
proprio, con i testi e le immagini.

Chi ha creato il CD ha realizzato una
directory “ data” e vi ha inserito il file
anticheiconerusse.aeh. Quindi ha realiz-
zato il resto della struttura del CD usando
“ Pubblica >CDROM” con il file
eikon.aeh.

In questo file si usano i collegamenti
appena descritti per puntare a data/anti-
cheiconerusse.aeh (ad esempio l’ imma-

gine in alto a destra di Fig.124 punta a
iper://cddrive:\data\anticheiconerusse.
aeh|1 cioè alla pagina 1 di anticheicone-
russe.aeh).

In pratica il CD è stato realizzato in
due passi: prima si è usato “ Pubblica
>CDROM” e si sono seguiti i normali
passaggi per creare un CD includendo
eikon.aeh (vedi Fig.126).

Quindi nella directory temporanea si è
aggiunta una cartella “ data”, e dentro essa
è stato salvato il fil e anticheicone-
russe.aeh che contiene il catalogo vero e
proprio. Con un programma di masteriz-
zazione si è quindi trasferita la directory
temporanea (in figura u:\cds\Eikon) nella
root di un CD. Aprendo il CD con l’Ex-

Fig. 125 - I
collegamenti

presenti in
Eikon.aeh, che

puntano a
diverse pagine

dell’ipertesto
anticheiconerus

se.aeh,
presente nella

cartella data
del CD

Fig. 126 - I
passaggi per

creare un CD in
cui alcuni degli

ipertesti non
siano riversati

su HD
dell’utente

finale.
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plorer di MSWindows si può verificare
questa struttura.

Lanciare programmi o file su
CD

E’ spesso utile lanciare un programma
residente su CD, o visualizzare un file
non direttamente supportato da HyperPu-
blish (ad esempio un PDF, o un file WAV
molto grande). Per fare questo occorre
scegliere “ Inserisci >Collegamento” , sce-
gliere la linguetta “ Indirizzo Internet -
programma” e inserire qualcosa come:
run:cddrive:\prova\prova.exe

Quello che abbiamo scritto significa
che al clic sul collegamento, il programma
cerca nella directory “ prova” del CD il
programma “ prova.exe” . La funzione run:
funziona anche con programmi residenti
sull’ HD, con path assoluti o relativi
(relativi all ’ ipertesto che contiene il li nk).

HyperPublish conosce il drive CD per-
ché l’ installazione automatica creata dal
Wizard lo determinerà. Se l’utente avesse
più CD-Drive, e durante utili zzi succes-
sivi cambiasse drive, HP non troverà
l’exe, e chiederà  semplicemente all ’u-
tente di introdurre il percorso per il CD
(quindi lo memorizzerà per ogni succes-
siva evenienza). Oltre che ai file .exe si
può lanciare qualsiasi altro file, posto che
il corrispondente programma lettore sia
installato in Windows.

Le parole chiave
Il programma automaticamente in-

cluso nei CDROM, il lettore
“ iPerReader” , fornisce all ’ utente finale
due funzioni molto utili: l a ricerca “ full -

text” con operatori booleani (and/or, vale
a dire e/o) su ogni ipertesto, e la ricerca
per parola chiave. Per la ricerca full -text
non occorre fare nulla, è inclusa automati-
camente. Se si desidera anche usufruire
della ricerca per parole chiave, queste
vanno definite manualmente in fase di
creazione del lavoro.

Per ogni ipertesto/lavoro ipermediale è
possibile definire un numero infinito di
parole chiave, dette “ parole chiave glo-
bali ” . Basta premere il pulsante a forma
di chiave (oppure “ Ipertesto >Parole
chiave” ), quindi nella finestra che appare
premendo il pulsante con una chiave e il
segno +.

Per ogni pagina si possono assegnare
fino a 20 parole chiave, prendendo dalla
lista di parole chiave globale: cioè nel
caso si intenda assegnare la parola chiave
“ Topolino” alla pagina corrente, basta
aggiungere “ Topolino” alla lista di
“ parole chiave globali ” , quindi con il drag
& drop la si porta nella casella superiore
della finestra, che lista le parole chiave
definite per la pagina corrente.

Durante la pubblicazione in Internet le
parole chiave vengono tradotte nell ’op-
portuno tag “ META” adatto ai motori di
ricerca.

L’utente finale di ogni CD realizzato
con il Wizard di HyperPublish può fare le
ricerche con il menù cerca o con l’appo-
sito pulsante.
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colo nel carrello della spesa (che viene
visualizzato in una finestra popup la quale
può essere stampata o inviata al vostro
indirizzo email ).

Per definire le proprietà del carrello
usa "Ipertesto >Proprietà dell'ipertesto
corrente" e quindi la linguetta "carrello".

Per aggiungere un collegamento al car-
rello della spesa, seleziona un blocco di

7yperPublish include un car-
rello della spesa sia per il Web che per i
CDROM. Si può inserire in modo assolu-
tamente visuale, senza dover sapere nulla
di programmazione.

In pratica qualsiasi testo o immagine
può scatenare un inserimento di un arti-

Fig.200 - La
linguetta in cui si

possono definire le
proprietà di un

collegamento a
carrello: il prezzo, il

codice, la
descrizione del

prodotto da
aggiungere...
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testo e usa "Inserisci >Collegamento a
carrello della spesa", oppure seleziona
un'immagine e usa "Immagine >Definisci
collegamento speciale..." (quindi l 'ultima
linguetta). Ciascun collegamento include
il prezzo del prodotto, la valuta (la prede-
finita è l'Euro ma si può cambiare), una
descrizione e un codice prodotto.

Con "Ipertesto >Proprietà dell 'iperte-
sto corrente" e quindi la linguetta

"carrello" si possono definire le proprietà
del carrello della spesa: si può definire un
indirizzo email (il contenuto del carrello
verrà inviato a questo indirizzo email ) o il
nome di un CGI, un numero fax, e i colori
per le righe del carrello. Per il Web, se sei
un esperto Javascript puoi anche modifi-
care lo script del carrello (se non lo sei,
non toccare nulla e lo script standard fun-
zionerà perfettamente).

Fig.201 - la videata
in cui si possono

definire le opzioni
del carrello: l’email
o il cgi cui inviare i

dati, eventuale fax,
colori, un

commento...

Fig.202 - Esempio
del carrello quando

abbiamo inserito
due articoli... Per

visualizzare il
carrello, inserire un

link a carrello,
quindi clic sul link

(o doppio clic,
nell’editor)



63

8l contenuto di questo capitolo, vale a
dire qualche breve indicazione su come
costruire e impaginare un CDROM o un
sito Web, esula un po’ dagli scopi di un
manuale. Tuttavia crediamo che qualche
consiglio possa essere utile: dopotutto uno
strumento potente come HyperPublish
non basta da solo per creare lavori “ ben
fatti” .

Non è lo strumento usato e nemmeno
la ricchezza di grafica e di effetti speciali
a rendere eff icace un sito Web o un CD,
così come non è suff iciente avere espe-
rienza nell ’ impostazione di riviste o nella
grafica su carta per essere automatica-
mente in grado di confezionare un buon
sito.

Se pure le regole fondamentali della
comunicazione e del marketing (per quan-
to riguarda siti commerciali ) rimangono
ben salde, per quanto riguarda l’ imposta-
zione grafica e funzionale sia i CDROM
che i siti Web sono sistemi di comunica-

zione a sé rispetto agli altri mezzi di
comunicazione di massa.

Mostri sacri della grafica stanno pro-
digando senza economia le loro energie
sulla rete, dozzine di teste pensanti creano
ogni giorno siti eccezionalmente decantati
e pubblicizzati: be’ , seguendo qualche
piccolo consiglio potrete fare siti e CD
forse meno perfezionati graficamente, ma
complessivamente più eff icaci.

Presentare informazioni su
video

La prima cosa da fare se si desidera
creare un buon CD / sito / catalogo è
prendere atto del fatto che presentare in-
formazioni su carta è molto differente dal
presentarle sul video di un computer, e
regolarsi di conseguenza. Per la carta,
scelta la dimensione della singola pagina
di stampa, il grafico è libero di posizio-
nare al milli metro testi e immagini, e può
sbizzarrirsi senza ulteriori problemi nel
disegno della pubblicazione. Per il video

  ��;́ X\_PVX]PiX^] � � [P
VaPUXR � ]T[�FTQ



64

Fig. 134 - Una
semplice pagina

progettata
correttamente per

Internet vista in
finestre di

dimensioni diverse



65

seguire la stessa strada può essere perico-
loso: non è più l’autore infatti a scegliere
la dimensione con cui viene visionato il
lavoro, ma l’utili zzatore.

Le informazioni possono essere rap-
presentate su un’area di schermo che va
tipicamente da 10 a 21 polli ci, con risolu-
zioni da 640x480 a 1600x1280 pixel.

Come fare per accontentare tutti? Ci
sono diverse soluzioni per superare questo
inconveniente. Per sempli cità, sapendo
che l’utente dispone sicuramente di al-
meno 640x480 punti, potreste progettare
tutto in funzione di questa risoluzione.
Questo accade per diverse pubblicazioni
professionali , forse per la maggior parte
delle opere su CD. Chi è abituato ad
approfittare di una risoluzione più elevata
può trovare molto limitativa questa impo-
stazione, e ai suoi occhi indubbiamente il
vostro lavoro scade di qualità.

Un’altra soluzione semplice consiste
nel preparare il l avoro come fosse un libro
o una rivista su carta stampata. Si defini-
sce ad esempio la dimensione A4 per ogni
pagina, e si fornisce all ’utente un pro-
gramma di visualizzazione con funzioni
di zoom che saranno usate dagli utenti con
monitor più piccolo. In questa maniera
ogni pagina avrà una dimensione fissa, il
suo contenuto sarà uguale per tutte le
risoluzioni. Questo è il sistema utili zzato
da molte pubblicazioni distribuite con
Acrobat Reader™. Obiettivamente questo
sistema rende la lettura piuttosto scomoda
agli utenti in possesso di monitor piccoli o
in bassa definizione.

Tutto è relativo
HyperPublish usa un terzo accorgi-

mento, e cioè quella giustificazione auto-
matica che dagli albori del WWW ad oggi
continua a portare successo alla distribu-
zione di informazioni tramite Internet. E
che allo stesso modo può rendere comodo
e fruibile il vostro catalogo su CDROM.

Con questo sistema quanto appare sul
video dell ’utente non è mai definito con
precisione assoluta, ma è determinato
dalla ampiezza della finestra di visualiz-
zazione. Per prima cosa il testo si adatta
alla larghezza della finestra, per cui re-
stringendo la finestra di visualizzazione,
si restringe anche l’ampiezza orizzontale
di ogni li nea (un esempio è nelle Fig.134).
Per seconda cosa, per restare coerenti con
questo sistema, se ci sono da posizionare
oggetti sulla pagina si preferisce specifi-
carne la posizione in percentuale, usando
tabelle senza bordo (o tabelle
“ invisibili ” ). La differenza tra  “ in per-
centuale” e “ assoluto” si può osservare
confrontando rispettivamente la Fig.134
con la
Fig.135 (si
noti che da
tutti gli al-
tri punti di
vista que-
ste pagine
sono dise-
gnate bene
e con stile;
in rete c’è
sicuramente di peggio, ma siccome anche
i manuali hanno un’anima abbiamo prefe-
rito questo esempio per non far soffrire
eccessivamente il nostro).

Purtroppo le pagine preparate con po-
sizionamenti assoluti hanno lo svantaggio
di richiedere all ’utente di usare la stessa

Internet � � � r sua de-
finizione libera: i sugge-
rimenti che vi diamo
sono dettati solo dalla
nostra personale espe-
rienza, e naturalmente
non abbiamo la pretesa
di giudicare nessuno.
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Fig. 135 - Una
pagina progettata

con riferimenti
assoluti vista in

diverse risoluzioni
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Fig. 139 -
Inseriamo le

immagini e
creiamo una

tabella con due
colonne, senza

bordi...

Fig. 140 - ...quindi
ci scriviamo dentro

(le linee
tratteggiate

appaiono solo
nell’editor, e non

appariranno nella
versione pubblicata

in rete).

Fig. 141 - Una
pagina con uno

sfondo quadrato
ripetuto in

orizzontale e
verticale

vostra risoluzione video e la stessa vostra
finestra del browser. Facendo una stima
ottimistica, questo sarà vero per il 10-
15% degli utili zzatori: gli altri vedranno
nel caso migliore una pagina bruttina, nel
peggiore una pagina ai loro occhi vera-
mente malfatta. È chiaro che il gioco non
vale la candela: è meglio quindi adattarsi
alla filosofia delle tabelle in percentuale,
accettando il fatto che ha una sua ragion
d’essere.

Questo è particolarmente vero se
usiamo il CD o il sito per vendere qual-

cosa: il cliente ha sempre ragione, e deve
trovarsi comodo, o andrà probabilmente
da qualcun altro.

Tabelle invisibili
Come si fa a introdurre tabelle in per-

centuale e fare in modo che si adattino
bene ad ogni risoluzione? È molto sem-
plice, le tabelle in percentuale sono lo
standard per HP. Proviamo ad esempio a
rifare la Fig.135 cercando contemporane-
amente di eliminare l’ impostazione asso-
luta che rende la pagina dipendente dalla
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Fig. 143 -
Applicando uno
sfondo colorato

alla tabella si
elimina lo sfondo
della pagina e si

rende pi !
comprensibile il

testo

Fig. 148 - Un
effetto di

trasparenza.
E’ stato realizzato

usando due
immagini di sfondo

diverse, simili ma
con diversa tonalità

cromatica.

risoluzione video.
Salviamo innanzitutto le tre immagini

da Netscape o Explorer (la scritta
“ Golem” , il numero, i pallini di divi-
sione). Quindi apriamo HP, definiamo il
bianco come colore di sfondo (“ Formato
>Proprietà pagina”; volendo si può anche
usare un’ immagine come sfondo), e pren-
diamo le immagini usando “ Inserisci >
Immagine” . A questo punto per disporre il
testo come nella pagina in Fig.135 oc-
corre creare una opportuna tabella invisi-
bile, che farà da griglia per il testo. Ciò si
ottiene premendo il pulsante di inseri-
mento tabelle o con “ Inserisci >Tabella”.
Occorre semplicemente porre 2 come nu-
mero di colonne. A video, facendo clic
con il tasto destro del mouse dentro cia-
scuna delle due caselle, si potranno defi-
nire le percentuali di ciascuna colonna

(seconda linguetta, come in Fig.44). Si
arriverà a Fig.139. Inserendo quindi il
testo si ottiene la pagina in Fig.140, che
ha la pregevole caratteristica di poter es-
sere ingrandita e rimpicciolita lateral-
mente senza gravi effetti collaterali .

Si noti che in ogni casella di una ta-
bella si può inserire un’altra tabella, e
così via, in gradi crescenti di complicazio-
ne. L’esempio da noi scelto è semplice,
tuttavia dovrebbe servirvi a prendere con-
fidenza con lo strumento: per migliorare il
vostro rapporto con questo sistema di im-
paginazione il modo migliore è provare ed
ancora provare.

Gli sfondi
Una delle caratteristiche che maggior-

mente differenziano un sito o un CD dalla
carta stampata è il divertente utili zzo che
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Fig. 154 - Una
mappa

cliccabile
spettacolare

(www.
fantascienza.

com).

si può fare di sfondi colorati.
Su carta l’uso di sfondi sarebbe antie-

conomico e a volte antiestetico. Su video
in genere un buono sfondo arricchisce.
Nelle Fig. 141, 143, 148 potete vedere
diversi esempi di sfondo. Per assegnare
uno sfondo a una casella di una tabella si
usa la solita finestra di Fig.44. È impor-
tante non esagerare: uno sfondo con con-
trasto troppo elevato o con particolari
troppo piccoli può far perdere di leggibi-
lità al testo. In genere sfondi con forti
contrasti cromatici, forte saturazione dei
colori, particolari e cose simili sono scon-
sigliabili . Al limite si possono usare co-
prendoli con una tabella colorata laddove
si desidera inserire il testo (Fig.143, dove
abbiamo usato tabell annidate).

Mappe cliccabili, hot spots,
barre di navigazione

Un sistema interessante per collegare
pagine diverse è realizzare immagini par-
ticolari che una volta cliccate, a seconda
della zona dove avviene il clic causano il
cambio pagina. Troviamo un’esempio ela-
borato in Fig.154, ma si può più semplice-
mente realizzare una barra rettangolare

orizzontale.
Per inserire zone cliccabili (o “ Hot

spots” basta usare il tasto destro del
mouse, con il cursore posizionato sulla
zona (Aggiungi zona). Appare a questo
punto un rettangolino con 4 angoli bian-
chi. Questo rettangolino si può trascinare
sulla figura e va a definire una zona clic-
cabile. Tirando gli angoli con il mouse il
rettangolino si può allargare e restringere.
Per definire i collegamenti basta usare
sempre il tasto destro del mouse, posizio-
nandosi sulla zona.

È importante tenere sempre conto de-
gli utenti che navigano con la parte gra-
fica disabilit ata: per non lasciarli abban-
donati preparate sempre dei collegamenti
in semplice testo (anche in piccolo) che
replicano quelli della mappa cliccabile e
inseriteli magari in fondo alla pagina. In
dotazione al programma ci sono diverse
immagini che esempli ficano la funzione di
barra pulsanti o di mappa cliccabile. Le
barre sono usate molto di frequente in
Internet, e, specie se ripetute su più pagine
all ’ interno dello stesso sito contribuiscono
a dare una veste grafica uniforme al pro-
getto, insomma concorrono a formare lo
“ stile” del sito.
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Proprio per questo motivo il disegno di
barra pulsanti o di una mappa graficamen-
te accattivante non è in generale un com-
pito semplice. Se non avete pratica di un
programma di elaborazione immagini vi
servirà parecchio tempo per ottenere risul-
tati presentabili . Prima di darvi per vinti
ricorrete ad un amico molto paziente
esperto di grafica, o cercate una pubblica-
zione specializzata sulla video-grafica.

Le cornici o frames
Le cornici sono una caratteristica ve-

ramente comoda da sfruttare specie se si
concepiscono lavori complessi. Utili zzare
le cornici significa in pratica dividere la
pagina in più sezioni. Un uso tipico delle
cornici consiste nel lasciare a sinistra di
ogni pagina un piccolo riquadro che con-
tiene un menù. Questo evita di dover ripe-
tere il menù in ogni pagina: allo stesso
tempo la presenza costante di un menù
laterale facilit a la navigazione.

Ci sono alcuni testi che sconsigliano
l’uso dei frames, anche riguardo ai piaz-
zamenti nei motori di ricerca. In realtà la
cosa da sconsigliare non è l’uso dei fra-
mes, ma il cattivo uso. Dal momento che
ogni volta che usate i frames HP genera
automaticamente pagine aggiuntive visi-
bili anche da browser “ non frame capa-
ble” e dai motori di ricerca, e che la
gestione dei collegamenti in HP general-
mente impedisce di fare pasticci, con un
minimo di buon senso potete tranquill a-
mente usare i frames. L’uso delle cornici
e l’uso abbinato dei collegamenti speciali
sono spiegati nei Cap.5 e 8.

È interessante notare che scegliendo 0
come margine per le cornici il  bordo delle

stesse diventa invisibile. Questa caratteri-
stica, unita alla possibilit à di far scompa-
rire le barre di scorrimento laterale
(scroll -bar) consente di realizzare interes-
santi effetti grafici.

Non strafare
Per prendere la mano con le possibilit à

offerte dalle tabelle invisibili , dalle cor-
nici, dagli sfondi e dalle mappe cliccabili
è necessaria solo un po’ di pratica e un
po’ di spirito di osservazione. Oltre a
questo, è ormai obbligatorio impratichirsi
nell ’utili zzo di un prodotto di grafica pro-
fessionale. Insomma bisogna procurarsi
qualcosa in grado di produrre gli effetti
più diversi (texture, lenti, aliasing e smor-
zamento immagine, ecc.) e imparare ad
usarlo seriamente per produrre bottoni,
immagini, mappe, striscie di separazione,
sfondi.

Superati i passi precedenti, per realiz-
zare pagine veramente efficaci rimane
solo da seguire la regola numero uno del
grafico, che dice “ non strafare!” . Dispo-
nendo di tanta potenza creativa è molto
diff icile limitarsi, ma è necessario.

Usare lo stesso sfondo per tutte le
pagine, usare al massimo due font, uno
per il testo e uno per i titoli , usare al
massimo 3 dimensioni del font stesso:
queste sono regole fondamentali assoluta-
mente da rispettare. Solo se sceglierete
uno stile grafico uniforme, e vi atterrete
ad esso per tutto l’ ipertesto, avrete un’ im-
paginazione realmente riuscita ed accatti-
vante. E questo vale sia per un sito che
per un catalogo o un CDROM iperme-
diale.

Non serve davvero altro.
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?er qualsiasi domanda relativa al
programma si può contattare il supporto
tecnico: support_hp@visualvision.com.

In questa pagina abbiamo raccolto le
risposte a diverse domande frequenti, di-
vise per argomento:

− tutorial, pubblicazione e di base
− pagine e collegamenti (link), fun-

zioni ipertestuali
− tabelle
− immagini, aree cliccabili , hot spot,

sfondi, thumbnails, icone
− stili e caratteri
− frames, cornici
− modelli
− pubblicazione Internet - FTP
− pubblicazione CDROM
− HTML Help, WinHelp
− HTML - AEH - ASP
− download / .DOC / .ZIP / .PDF /

Flash / Accessori Internet / Conta-
tori / Forum / Importare file

− carrello della spesa, e-commerce
− domande varie, generiche
− acquisto, registrazione

TUTORIAL - PUBBLICAZIONE - DI
BASE
Ci sono dei tutorial per iniziare?
Certo, nel manuale online (si può visionare
con “?-Guida” quindi “Help” ). E’ tutto in-
cluso anche nella versione di prova gratuita .
C’è anche la possibilit à di scaricare il ma-
nuale stampabile in formato PDF (questo che
stai leggendo).

Il programma può gestire i frames? Può
gestire il mouseover? Può gestire i form?
Può creare CD? Può pubblicare diretta-
mente in Internet? Può fare il caffè....?
In generale la risposta è sempre sì (a parte il
caffè... ma ci stiamo lavorando!). Per saperne
di più, puoi dare un’occhiata al tour veloce,
oppure visionare direttamente il manuale on-
line, che ne ill ustra tutte le caratteristiche, o i
tutorial. Se scarichi il  trial gratuito, il ma-
nuale online è incluso. Se acquisti il  CD, c’è

 !��3^\P]S " UaT`dT]cX
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anche il manuale cartaceo.
Ho scaricato la versione di prova. Non capi-
sco come fare a farla funzionare. Potete
segnalarmi qualcuno che può insegnarmi
come usare il programma o che posso assu-
mere per fare il l avoro di cui ho bisogno?
Ci sono molte aziende specializzate nel creare
siti Web o CDROM. Puoi anche provare a
chiedere nel Forum dedicato al programma. Il
software non è più complicato del diffusis-
simo MSWord, quindi un’alternativa po-
trebbe essere convincere un amico un po' più
bravo con il computer ad aiutarti. Dopo aver
installato il programma, cercalo nel menù
"Start", sotto "Programmi", "Visual Vision".
Quindi, nella finestra principale del pro-
gramma, cerca il menù "?-Guida", quindi
"Help", poi fai clic su "Tutorial" e leggi tutti i
tutorial. La confezione di HyperPublish in-
clude un manuale cartaceo che spiega passo
passo come creare un CD o un sito Web.

Ci sono altre cose da sapere per fare un
sito? Dove lo pubblico? Come funzionano i
“ dominii ” ? HyperPublish può pubblicare su
qualsiasi sito?
Sì, HyperPublish può pubblicare ovunque.
Clic qui per una pagina che spiega in modo
semplice come creare un sito Web e le cose
fondamentali da sapere.

Ho usato altri editor HTML e non capisco
bene come maneggiare i file HTML in Hy-
perPublish.
In HyperPublish non si maneggia HTML,
siccome non è un Editor Html classico. E’ un
programma per creare CDROM, cataloghi,
siti Web, manuali . Non occorre maneggiare
direttamente file, si crea un catalogo o un sito
e poi fa tutto il programma.

Posso importare il sito che ho già creato con
un altro programma?
Sì, con “File >Importa”, scegliendo il formato
HTML dalla lista. E’ possibile che serva rifor-

mattare il testo o fare modifiche, siccome HP
importa bene solo le cose perfettamente com-
patibili con tutti i  browser. La eventuale pic-
cola fatica è ripagata dal fatto che un lavoro
fatto con HP si vede bene su tutti i browser, si
può pubblicare oltre che sul Web su CDROM
con motore di ricerca e anche in HTML Help.

Ho importato delle pagine HTML ma non
riesco a vedere nulla!
Usa CTRL+ CTRL- per muoverti tra le pa-
gine.

PAGINE E COLLEGAMENTI (LINK),
FUNZIONI IPERTESTUALI
Non capisco il modo in cui HyperPublish
“ salva” le pagine...
Tutte le pagine di un ipertesto sono salvate in
un file “AEH” . Con “File >Salva tutto” o con
l' omonimo pulsante della toolbar, si salvano
tutte le pagine di un ipertesto con un clic,
contemporaneamente.

...nel tutorial dite... premiamo il pulsante
nella toolbar (foglio e catena o “ Inserisci
>Collegamento” dal menù principale, ma io
non vedo nessun pulsante che si chiama
“ collegamento” nella toolbar, e poi, quale
toolbar?
Scegli un blocco di testo, quindi scegli nel
menù principale “ Inserisci” quindi
“Collegamento” , se non trovi il  pulsante con
foglio e catena. Se sei su un’ immagine, usa il
pulsante destro del mouse e scegli “Definisci
collegamento...” .

Come faccio a stabili re la misura di una
pagina?
Non si può stabili re la "misura" di una pa-
gina, siccome a priori non puoi sapere con che
monitor o con che finestra verrà visionata.

Avevo un ipertesto di 5 pagine e volevo
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modificarlo rinumerando le pagine perché
volevo aggiungere una pagina tra la pagina
1 e la 2, ma non ci sono riuscita.
Infatti non è possibile. Comunque, se proprio
serve, puoi inserire una pagina 3, copiarci la
pagina 2 con "Modifica >Incolla pagina da..."
quindi cancellare tutto il testo a pagina 2. E'
un po' macchinoso ma la numerazione ha
delle ragioni (in sintesi serve a velocizzare la
pubblicazione) non c'è altro modo.

Posso rinumerare la pagina 0?
La pagina 0 serve da presentazione e così non
è possibile cambiarla per farla diventare 1 e
metterne un'altra come quella di inizio. In
“ Ipertesto > Proprietà > Ipertesto” è possibile
assegnare a qualsiasi Pagina la funzione di
copertina, non solo alla 0 (che è quella prede-
finita). La pagina 0 dunque non è rinumera-
bile. Però è possibile definire come pagina di
inizio una pagina diversa dalla 0. In "Ipertesto
> Proprietà Ipertesto" è possibile assegnare a
qualsiasi pagina la funzione di copertina, non
solo alla 0 (che è quella predefinita).

Per progettare una pagina a 535 pixel in
modo che possa essere stampata su un foglio
A4 come si fa?
Si può imporre ad una tabella quella dimen-
sione in larghezza. Se proprio vuoi, usando le
Proprietà di una tabella, puoi impostarla come
"fissa" cioè larga un numero predefinito di
pixel. La norma migliore però è usare dimen-
sioni in % per le tabelle così queste vengono
adattate alla risoluzione video dell ’utente.

Non capisco come inserire un collega-
mento...
Selezionare un blocco di testo, e premere il
bottone "collegamento", quello con una pa-
gina e una catena. Nella finestra che appare, è
possibile collegarsi ad una pagina esistente
nel corrente ipertesto, oppure in una pagina
nuova (e molte altre cose). Per esempio sce-
gliere "nuova pagina", e premere OK: Hyper-

Publish aggiunge all 'ipertesto una nuova pa-
gina, fa in modo che sia la destinazione del
collegamento in costruzione, e la mostra nel-
l'editor. Lavorando con più pagine si può
facilmente notare che se ci si collega ad una
pagina esistente, la si può scegliere da una
anteprima "attiva" (significa che è possibile
navigarci come in un browser).

Come faccio a fare un collegamento all ’ in-
terno della stessa pagina?
I collegamenti all 'interno della stessa pagina
sono detti "Ancore". Bisogna stabili re le de-
stinazioni di li nk interni alla stessa pagina.
Per fare questo posizionarsi nella pagina al-
l'altezza della destinazione del li nk e fare clic
sul menu “ Inserisci >Ancora” . Comparirà
un'icona con il simbolo dell 'ancora. Selezio-
nandola con il tasto destro del mouse si pos-
sono vedere anche le proprietà. HP numera
(partendo da 0) le ancore di ciascuna pagina.
A questo punto posizionarsi in un’altra parte
della pagina e selezionare la parola da
linkare. Subito dopo usare “ Inserisci
> Collegamento speciale” : compare una fine-
stra dove la prima linguetta è "Ancora nella
stessa pagina". Fare clic su Ok. Compare una
schermata nella quale si può selezionare l’an-
cora di destinazione del li nk. Si visualizzerà
una finestra nella quale si può fare tutto in
modo visuale. Il risultato lo si può verificare
da anteprima (” Ipertesto >Sola lettura”) dopo
aver salvato.

Come faccio a fare un collegamento ad
un’ancora di un’altra pagina?
Seleziona la parola che si vuole collegare dal
menu "Inserisci" selezionare "Collegamento
speciale". Dalla finestra che appare, la prima
linguetta propone collegamenti ad ancore
della stessa pagina. Basta scegliere una qual-
siasi delle altre linguette (ad es. la seconda
"Normali " e con l’opzione "nella finestra cor-
rente" e dare Ok) e selezionare la pagina di
destinazione. Nell ’anteprima che compare a
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video, cerca l’ancora e fai un clic. Oppure,
sulla destra in basso sotto l’anteprima della
pagina di destinazione c’è una finestra che ti
permette di indicare il valore numerico dato
ad un’ancora in quella pagina. In questo caso
digita il numero dell ’ancora a cui vuoi colle-
gare, e premi Ok.

Come posso inserire del testo alternativo ad
un link testuale come si fa per le immagini?
Seleziona il testo e dal menu "Inserisci
>Collegamento speciale (tasto F5 della ta-
stiera) fai clic sulla linguetta "html". Nel box
di inserimento testo puoi scrivere la seguente
tag: TITLE="inserisci qui il  testo del tooltip".
Fai clic sulla linguetta in alto "Tipo di colle-
gamento" e scegli l a seconda "Normali ". Sele-
ziona "Nella finestra corrente..." con il check
della "Pagina di destinazione" e poi fai clic su
Ok. Appare la finestra con l’elenco delle pa-
gine create per selezionare quella di destina-
zione. Seleziona e conferma con OK.

Cosa devo fare per salvare una singola pa-
gina?
Si può usare "File >Salva come...", o "File
>Esporta pagine". In questo modo è possibile
ottenere per esempio una singola pagina Rtf o
Html.

E' possibile avere link con colori diversi
nella stessa pagina?
Sì, basta definire diversi stili con "Formato
>Stile" o "Formato >Nuovo stile". Usando
l' ultima linguetta si può definire non solo il
colore ma anche lo stile del collegamento.
Siccome ogni paragrafo può avere uno stile
differente, ogni paragrafo può avere colori
diversi per i li nk.

Dove posso trovare informazioni sulle pa-
gine contenute in un ipertesto? Come posso
organizzare le pagine?
Creazione: "Inserisci >Nuova pagina", oppure
"Inserisci >Collegamento".

Cancellazione, organizzazione: "Ipertesto
>Album immagini /files /pagine e cancella-
zioni".
Accesso: "Ipertesto >Vai a pagina", oppure la
casella sulla toolbar in basso al centro, tasto
destro del mouse su questa casella.

Quando edito un file *.aeh, come posso can-
cellare una pagina (nel mio caso pagina 0,
siccome è vuota)?
La pagina 0 è particolare e non può essere
cancellata. Per le altre pagine, usare invece
"Ipertesto >Album immagini /files /pagine e
cancellazioni". Si può fare copia e incolla da
un' altra pagina per riempire la pagina 0.

Come posso collegarmi ad una pagina Html
esterna, per esempio una pagina già esi-
stente sul mio sito WWW?
Selezionare un blocco, premere il pulsante di
collegamento, nella finestra che appare sce-
gliere "Internet" tra le "linguette" in alto, scri-
vere nel box a destra l' indirizzo destinazione
(ad esempio "http://mysite.com/mypa-
gehtm"), quindi premere "OK".

Oltre che tramite un link, come posso acce-
dere e gestire le pagine che non sono quella
principale?
In basso al centro c' è numero pagina corrente,
e facendo clic con il tasto destro del mouse su
di esso si accede una lista delle pagine visitate
più recentemente. Inoltre si può usare:
"Ipertesto >Album", "Ipertesto >Vai a pa-
gina", "File >Tutte le pagine"...

Come posso copiare una pagina da un'altra,
nello stesso sito / ipertesto (con Html potevo
fare questo con "salva come...", poi "apri":
c'è un altro modo in HyperPublish)?
"Inserisci >Nuova pagina", quindi "Nuova
pagina copiandone una esistente", oppure
"Nuova pagina copiando da un' altro iperte-
sto", ... Si può anche usare "Modifica >Incolla
pagina da...".
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Come posso gestire intestazioni e piè di pa-
gina?
Usa “? - Guida”, quindi “Help” , e poi cerca la
parola chiave “ intestazione” o “piè di pagina”
(”Cerca >Cerca parola chiave” ).
In breve, puoi usare qualsiasi pagina come
intestazione o piè di pagina per qualsiasi altra
pagina. Se vuoi un’ intestazione globale per
tutto il sito:
- crea una pagina e inserisci all ’ interno tutte
le cose che vuoi che compaiano nella tua
intestazione (un logo, una frase, ecc.)
- scegli “ Ipertesto >Proprietà dell ’ ipertesto
corrente” , seconda linguetta, e premi il  bot-
tone “scegli ...” vicino a “intestazione” . Nella
finestra che compare, scegli l a pagina che hai
appena creato.
Con “Formato >Proprietà della pagina cor-
rente” si può definire un’ intestazione perso-
nalizzata per ciascuna pagina (idem per il piè
di pagina).

Mi spiegate passo passo come creare, aprire
e chiudere finestre popup?
Per aprire una popup, scegli un blocco di
testo, "Inserisci Collegamento speciale",
quindi la terza linguetta (finestre volanti o
popup). Per chiudere una popup, nella pagina
nella quale la popup va chiusa, usare
"Inserisci >Funzioni di pagina >Apri/chiudi
finestre", quindi specifica il nome di una po-
pup. La popup sarà chiusa all ' ingresso nella
pagina.

Posso vedere le pagine a cui non ho inserito
link solo in modo "modifica", usando il box
nella parte bassa dello schermo, quello con
il numero di pagina, oppure CTRL+-. E'
normale? Questo tipo di navigazione tra le
pagine sarà attiva quando pubblicherò il
lavoro sul Web?
No, devi inserire link (collegamenti). Gli altri
modi per gestire le pagine sono attivi solo
nell ' editor (per sempli ficare la creazione/ge-
stione pagine).

C'è un limite nella lunghezza delle URL che
si possono inserire con "Inserisci
>Collegamento", terza linguetta?
Sì, c' è un limite interno. Puoi inserire link più
lunghi molto facilmente, usando blocchi
HTML ("Inserisci >HTML >Dentro alla pa-
gina"). Inserisci due blocchi HTML, il primo
davanti al testo/immagine a cui vuoi asse-
gnare il l ink: <a href="http://laurllunga-
qui.com/">, il secondo alla fine: </a>

TABELLE
Dimensioni % significa che la tabella si
adatta al suo contenuto in modo automatico?
Significa che la tabella si adatta in percen-
tuale alle dimensioni in pixel dello schermo.
Quando si inserisce una tabella con HP il
software la inserisce di per sé con dimensione
100%, per cui a meno che non abbiate esi-
genze particolari, va bene lasciarla così. Si
adatterà automaticamente a qualsiasi
schermo.

Perché se inserisco un'immagine in una ta-
bella questa viene in tutte le celle?
Forse hai inserito un' immagine come "sfondo"
di una tabella... Per inserirla come sfondo di
una sola cella basta selezionare la seconda
linguetta della finestra "Proprietà tabella" e
fare clic sull ’ icona "Immagine di sfondo".

Per scrivere parole in tre colonne devo usare
una tabella o basta disporle usando la barra
spaziatrice?
Meglio usare le tabelle. Mai usare la barra
spaziatrice perché ad esempio vedendo la pa-
gina su un altro PC la dimensione dello spa-
zio potrebbe variare leggermente.

Come si può creare una tabella che in una
riga abbia più colonne?
Si può inserire una nuova tabella con quante
righe e colonne si desidera in una cella di una
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tabella precedentemente creata.

Come faccio a cancellare una tabella?
Ci sono molti modi. Per esempio mettere il
cursore dentro una casella, premere il tasto
destro del mouse, quindi scegliere "Seleziona
tabella", e premere il tasto CANC.

Come faccio a copiare una tabella?
Selezionala (vedi sopra) quindi premi
CTRL+INS. Quindi muovi il cursore a desti-
nazione e premi SHIFT+INS.

Ho un problema per formattare un testo in
una tabella. Il testo della tabella è configu-
rato automaticamente come Times New Ro-
man, vorrei mettere Arial.
Lo stile predefinito per le tabelle è "[nessuno
stile in tabella]".
Cambia lo stile con "Formato >Stili ".

IMMAGINI - AREE - SFONDI -
THUMBNAILS - ICONE - HOT
SPOTS
Le GIF animate non si muovono nell 'editor!
Passa alla modalità anteprima ("Ipertesto
>Sola lettura").

Come si posizionano le immagini
"ancorandole" nella posizione prescelta?
Non riesco a muovere gli oggetti di una
pagina come vorrei! Quando ad es. seleziono
una foto o qualsiasi altra cosa, non riesco a
posizionarla nel punto che desidero.
Il posizionamento “ fisso” delle immagini è
una cosa che va bene quando si prepara un
testo da stampare su carta, ma non ha senso
sul Web quando l’utente può avere una fine-
stra larga un numero arbitrario da circa 600 a
1200 pixel, e noi non lo sappiamo. Per fare un
sito che si veda bene su tutti i computer, e
quindi un sito gradito da tutti i  visitatori, si
devono posizionare le immagini usando delle

tabelle (invisibili , senza bordo), usufruendo
delle righe e colonne create dalle tabelle.

Se voglio mettere un didascalia accanto ad
una immagine è meglio lavorare con le cor-
nici?
Meglio lavorare con la modalità tabella.

Come togliere l'immagine che ha invaso
quasi tutta la tabella?
Per cancellare un' immagine la selezioni e
premi CANC due volte. Per cancellare la
tabella, tasto destro del mouse, "seleziona
tabella", CANC.

Si può scrivere un testo e poi posizionarlo su
un'immagine? In pratica come se fossero 2
livelli ?
No, devi usare il PaintShop PRO o similari.

Sto cercando di togliere un'immagine di
sfondo alle pagine del sito che sto realiz-
zando, perché vorrei sostituirla: non ci rie-
sco. Cosa devo fare?
Il modo più semplice per cambiare lo sfondo
di tutto il sito è andare in "Ipertesto >Album
immagini", selezionare l' immagine di sfondo
attuale, e premere "Sostituisci..."

Come faccio ad affiancare un testo ed una
immagine?
Crea una semplice tabella con una riga e due
sole colonne, senza alcun bordo. Quindi in
una colonna introduci il  testo, nell ' altra intro-
duci l ' immagine.

Non riesco a far diventare trasparente
un’ immagine, usando le opzioni interne.
A volte è necessario usare programmi esterni
come Paint Shop PRO o Corel Photo Paint.

E' possibile aggiungere più di un'area clic-
cabile (hot spot) su un'immagine? Mi pare
che le aree cliccabili spariscano quando
pubblico in HTML.
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Bisogna evitare di "provare" le aree in modo
"sola lettura". Se si evita questo, funzionano
perfettamente. Si possono inserire fino a 20
aree (se ne servono di più, basta spezzare
l'immagine in più sezioni con un programma
di grafica).

Ho visto che l' "incolla da cartella appunti"
può convertire automaticamente l'immagine
in GIF / JPG per r idurre la dimensione del
file (byte size). Siccome ho già inserito im-
magini *.WMF senza convertirle, posso con-
vertirle in GIF ora in qualche modo o devo
reinserirle?
Purtroppo occorre reinserire.

Non r iesco a inserire GIF animate con
“ Inserisci >Animazioni"!
Usa "Inserisci >Immagini".

Dove trovo le clip art?
In Inserisci >Immagini, da disco, fai clic
sull ’ icona con montagna e sole.

Come posso inserire delle foto che vengano
ingrandite in una finestra a parte, cliccan-
doci sopra? Bisogna usare le aree clicca-
bili ? A cosa servono le aree?
Un’area serve per attribuire diverse destina-
zioni al clic su un’ immagine.
Ad esempio apponendo aree su un'immagine
della gioconda, si può fare in modo che fa-
cendo clic sul naso si vada ad una pagina di
spiegazioni sul naso, su un occhio a una
pagina di spiegazione sugli occhi e così via
per le mani ecc...
Per creare gallerie con ingrandimenti non è
necessario usare aree: in una pagina si inseri-
sce una serie di immagini piccoline, poi si
inseriscono le immagini grandi in pagine
nuove, una per pagina, quindi si assegnano
collegamenti alle immagini piccoline (tasto
destro del mouse sull ’ immaginetta, "Definisci
collegamento speciale"). Tramite il collega-
mento speciale si può specificare che l’ imma-

gine grande compaia in una finestra “popup” .

C'è un modo per mettere delle "icone" (o
thumbnails) nella mia pagina, e poi cliccarle
per vedere un'immagine più grande?
Sì, inserisci semplicemente una piccola im-
magine (puoi crearla con un programma di
Paint) quindi inserisci un link (tasto destro
del mouse "Definisci collegamento") verso
una pagina che contiene l'immagine più
grande. Usando "Definisci collegamento spe-
ciale" puoi anche mostrare l'immagine grande
dentro una finestra popup.

Come posso definire un'immagine di sfondo
o un colore di sfondo per una pagina?
“Formato >Proprietà pagina”, quindi l 'icona
con il cactus e il sole. Puoi anche inserire
tabelle con immagini come sfondo (per la
tabella, per una riga, per una colonna). Fai
clic su una casella con il pulsante destro del
mouse e scegli "Proprietà".

Ho disegnato una barra di navigazione in
Paint Shop PRO, come posso inserirla in una
pagina ed aggiungere un link a ciascun pul-
sante?
Usa "Inserisci >Immagine", quindi aggiungi
gli hot spots (aree cliccabili e) con il pulsante
destro del mouse, quindi definisci il collega-
mento per ciascuna area sempre con il pul-
sante destro del mouse.

Ho un'immagine e del testo in una pagina.
Voglio che il testo si alli nei a destra dell 'im-
magine, e suppongo che si debba usare un
frame (cornice).
Meglio usare una tabella semplice piuttosto
che un frame. Usa "Inserisci >Tabella" quindi
inserisci una tabella con 2 colonne e 1 riga
(Per creare frame basta trascinare i bordi zi-
grinati a sinistra e in alto).

Ho inserito un'immagine, c'è modo di ag-
giungere un bordo?
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Puoi farlo con un programma di Paint.

STILI E CARATTERI
Quando cambio la grandezza del carattere e
poi scrivo, questo ritorna della grandezza
precedente e devo selezionare per modifi-
care. Come fare per farlo direttamente?
Dipende dove inserisci il  cursore dopo che hai
modificato la grandezza del carattere. Il consi-
glio è comunque di usare gli stili (vedi ma-
nuale).

E’ possibile memorizzare gli stili ?
Certo che si possono memorizzare. Si può
anche importare uno stile da un altro ipertesto
/ catalogo / sito creato con HP. Basta scrivere
un nome nella casella stili , premere INVIO, e
le impostazioni del corrente paragrafo sono
memorizzate come stile. Per creare un nuovo
stile si può anche andare nel menù "Formato"
>Stili ". Per altri modi vedere il manuale. Den-
tro la finestra "Stili " si possono importare stili
da altri ipertesti (pulsante Importa).

Una volta memorizzati come richiamarli con
un clic?
Con un clic sulla freccia a lato del box stili (la
barra sotto il menu) si richiamano gli stili
memorizzati.

Come si fa per cambiare lo stile dei li nk in
tabella?
Come per qualsiasi stile, si usa "Formato
>Stili ". Lo stile predefinito dentro alle tabelle
è [nessuno stile tabella].

Ho creato un sito Web / CD ed ho usato
alcuno dei font installati nel mio computer
per le pagine. Il problema è quanto il sito/
CD viene visto da persone che non hanno
quei font. Devo usare solo i font che sono
universali , presenti su ogni computer?
Sì: Times New Roman, Arial e Courier New.

Se l'utente ha Windows e Office di solito
anche Verdana ed altri font sono disponibili .
Usa immagini GIF per rappresentare titoli
con font diversi. Per problemi di copyright
non è possibile fare diversamente.

FRAMES - CORNICI
Ho inserito dei frames (cornici) che vorrei
togliere, come faccio? Non devo riscrivere
tutto spero!
Per eliminare una cornice bisogna trascinarle
con il mouse verso la sinistra o verso l'alto (a
seconda della cornice).

Come si fa ad eliminare i bordi delle cor-
nici?
Si sceglie "Formato >Proprietà pagina
>Proprietà cornice" (oppure si usa il tasto
destro del mouse). Nella finestra che appare si
toglie la crocetta "bordo" e si pone a 0 il
valore "bordo tra cornici".

Sto lavorando con i frame e sembra che i
frame non mi permettono di alli neare testo/
immagini all ’angolo in alto a destra. Sembra
che abbiano un margine di qualche mm.
Come posso evitare questo?
Definisci uno stile in cui il  margine superiore
sia un numero negativo (-0.01 dovrebbe es-
sere sufficiente) e applica questo stile al
primo paragrafo. Poi potresti inserire una ta-
bella nel primo paragrafo e fare qualche
prova.

Voglio aggiungere una pagina con dei frame
(cornici). Voglio usare come frame una pa-
gina già esistente.
Crea un nuovo insieme di cornici (frame).
Dentro a un frame, usa il pulsante destro del
mouse per scegliere quale pagina andrà a
riempire il frame. Puoi anche usare "Formato
>Gestione avanzata cornici". Vedi anche il
capitolo del manuale sulle cornici.
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MODELLI
Come faccio ad usare i modelli ?
Con “File >Nuovo da...” scegliere la linguetta
apposita.
Oppure con “Modifica >Incolla pagina da...”
scegliere la linguetta apposita.

PUBBLICAZIONE INTERNET - FTP
Ho trovato delle difficoltà nel compilare i
parametri necessari alla pubblicazione del
mio sito. Io sono abbonato alla Wind.
Per pubblicare nel Web bisogna prima acqui-
stare uno spazio Web oppure procurarsi uno
spazio gratuito. Avrai allora i parametri da
inserire. Tutorial in "?-Guida" quindi "Help"
quindi "Tutorial" e "Pubblicazione Internet
FTP". Oppure vedi i capitoli i niziali di questo
manuale. Se non conosci le informazioni di
base sulla pubblicazione di siti Internet, vai a
www.visualvision.it/comecreareunsito/
dove abbiamo preparato le spiegazioni per
filo e per segno.

Per inviare solo le pagine finite del mio
lavoro e non tutte come faccio?
HP automaticamente individua le pagine mo-
dificate rispetto all ’ultima volta che si è ag-
giornato il sito e le "crocetta", a sinistra nella
finestra di pubblicazione. Se qualcuna non
vuoi pubblicarla, semplicemente
"scrocettala".

Il mio provider / host / ISP non ha idea di
quali siano i parametri FTP... non so come
pubblicare... dove devo mandare le mie pa-
gine??
Prima di pubblicare devi avere uno spazio
Web gratuito o a pagamento (clic qui per
qualche informazione). Ti comunicheranno i
parametri di pubblicazione FTP. Il tuo host
DEVE sapere questi parametri: nome del ser-
ver, username e password. Se non li sa, è
come un elettricista che non sa cosa sia una

lampadina, cambialo! Per comodità puoi sug-
gerire al tuo host di scaricare il trial gratuito
di HyperPublish (è gratis) così possono pro-
vare ad inserire i loro parametri ed eventual-
mente aiutarti. Oppure scrivici un’email e ti
aiuteremo noi. Però prima leggi il  Tutorial
FTP, l’abbiamo scritto apposta!!

Non riesco a pubblicare, mi dà un errore.
Errore 500 significa che il nome del server
non è corretto. Nota che normalmente bisogna
scrivere per esempio visualvision.com o
ftp.visualvision.com e non ftp://visualvi-
sion.com o http://visualvision.com. Errore
530 significa che è tutto a posto ma username
e/o password sono errate. Controlla l’user-
name (identificatore utente, o user), e magari
cancella la password e riscrivila. Nota che
molte password sono “case sensitive” , cioè le
maiuscole e le minuscole hanno importanza.
Altri problemi per l' FTP possono essere cau-
sati da Firewall (ad esempio alcune versioni
di ZoneAlarm hanno dei problemi).

Il mio sito si visualizza con Explorer e non
con Netscape. Come mai?
Questo a volte succede se nel menu
"Ipertesto" -> "Proprietà dell ’ ipertesto cor-
rente" alla voce "Prefisso per l’export" inseri-
sci un nome con spazi. Bisogna assoluta-
mente evitare gli spazi per essere a posto con
tutti i browser e sistemi operativi.

Se seleziono la voce "scegli automaticamente
modificate" nella pagina della pubblicazione
dell 'ipertesto, non me le seleziona...
Bisogna scegliere questa voce prima di colle-
garsi (cioè in altre parole questa impostazione
vale solo per la prossima volta che
si sceglie "Pubblica >FTP". In altre parole, se
la lista sulla destra (i file sul server) è già
completa, per forzare il programma a sce-
gliere automaticamente solo le pagine modifi-
cate occorre anche premere il bottone "reload"
(a forma di freccia circolare).



80

Dopo aver inserito un form (modulo) in una
pagina Web, l'ho provato usando il browser.
Quando ho premuto il tasto Ok è comparso
un messaggio: "Questo modulo è spedito
usando l'e-mail . Spedire questo modulo si-
gnifica rivelare il tuo indirizzo email ..." etc.
Cosa posso fare per r imuovere questo mes-
saggio?
Per eliminare il messaggio devi usare uno
script detto "formtoemail " che deve risiedere
sul server. Chiedi al tuo servizio di hosting o
al tuo provider come fare. Di solito questo
tipo di modulo si gestisce utili zzando un mar-
catore di inizio modulo di tipo "POST" o
"GET" (il tuo host ti dirà quale URL inserire
nel marcatore), e usando degli elementi mo-
dulistici di tipo "invisibile" (hidden) per spe-
cificare l'indirizzo di destinazione dell 'email
che verrà inviato. In pratica i dati invece di
andare direttamente all 'email passano allo
script il quale spedisce l'email .

Ho pubblicato una pagina, quindi sono an-
dato a vederla con il browser, ho fatto dop-
pio clic su un collegamento ma non è suc-
cesso nulla, ho dovuto usare il tasto destro
del mouse.
Quando pubblichi una pagina, un solo clic su
un link è sufficiente.

Posso pubblicare un sito composto da due
ipertesti diversi? Come faccio ad assegnare
un unica pagina iniziale, così che quando
uno vi entra vede solo quella del primo iper-
testo?
Nel secondo ipertesto, scegliere "Ipertesto
>Proprietà dell 'ipertesto corrente", seconda
linguetta, e deselezionare la casella "nome file
copertina" o assegnare un nome diverso da
index.htm

HyperPublish fa rilevare il mio sito nei vari
motori di ricerca della rete?
HyperPublish serve per costruire siti . Per far
rilevare il sito ai motori di ricerca bisogna

segnalarlo ai motori di ricerca. Ogni motore
ha una pagina di segnalazione in cui puoi
introdurre manualmente l 'indirizzo del tuo
sito e segnalarlo. Esistono software automa-
tici per la segnalazione, ma generalmente non
funzionano. I motori di ricerca che garanti-
scono il 99% del traffico sono cmq pochi:
Altavista, Google, Lycos, Excite, Virgil io,
Arianna.

Da un'analisi commissionata relativa ai mo-
tori di ricerca mi hanno detto che non ho i
META TAGS sul mio sito. Potete spiegarmi
come posso inserirli , tenendo presente che
non so nemmeno bene cosa siano.
Per ciascuna pagina, usa "Inserisci >HTML
>Ad inizio pagina" quindi puoi inserire quali -
sai META tag, ad esempio i più utili per i
motori di ricerca sono: <meta
name="keyword" content="giochi, supergio-
chi, ultra giochi">
<meta name="description" content="Questa
pagina parla di giochi">
Nell 'esempio sopra abbiamo definito parole
chiave e descrizione per una pagina che parla
di giochi. Nota che i META tag non sono
indispensabili , la maggior parte dei motori di
ricerca indicizzerà le tue pagine anche senza
di essi.

Posso "Pubblicare" su Internet con la ver-
sione trial?
Certo che puoi. Hai letto il Tutorial di pubbli -
cazione FTP? Vedi "?-Guida >Help" quindi
"Tutorial".

Ho 5 o 6 pagine del mio sito pronte, e voglio
che una di queste rimpiazzi la homepage,
cioè la pagina '0'. Come faccio a farlo e
muovere la pagina 0 a pagina 2 o qualcosa
del genere?
Ci sono due modi:
1) in "Ipertesto >Proprietà dell 'ipertesto cor-
rente", scegli l a seconda linguetta. Quindi,
sulla sinistra, puoi scegliere la pagina
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"copertina" e la pagina "sommario". La pa-
gina "copertina" non è nient'altro che la home
page (di default, pagina 0)
2) usa il copia e incolla, e incolla la nuova
homepage dentro pagina '0' (puoi anche usare
"Modifica >Incolla pagina da...")

Quando ho pubblicato su Internet mi pare
che le pagine non siano state tutte corretta-
mente aggiornate.
Innanzitutto verifica che non sia un problema
di "cache" del browser (usando il pulsante
Aggiorna + il tasto maiuscole). Se non è così,
la via più veloce è ripubblicare tutto pre-
mendo prima di "Pubblica" il pulsante "Tutte"
in basso a sinistra nella finestra FTP. Siccome
Internet non è perfetta, può succedere che per
cause imprevedibili durante la pubblicazione
sul server sia rimasto qualche file della ver-
sione precedente. Per fortuna capita rara-
mente.

Ho creato un sito Web con il vostro pro-
gramma e voglio effettuare l'upload
utili zzando il mio FTP e non quello fornito
con il programma stesso. Dove posso recu-
perare i file relativi al sito Web, in maniera
manuale?
E' un procedimento sconsigliabile, perche' fa-
cendo cosi' non puoi usare l'ottimizzatore in-
terno che provvede a pubblicare solo i file
effettivamente modificati. Se avrai un sito di
50-100 pagine sara' parecchio scomodo. Co-
munque, basta usare "Pubblica >Esporta pa-
gine" quindi scegliere HTML.
Nella linguetta Path puoi scegliere la direc-
tory dove salvare i file.

PUBBLICAZIONE CDROM
La licenza che acquisisco con il programma
mi può permettere di realizzare eventuali
lavori multimediali i n CDROM per clienti
committenti? Se sì cosa deve risultare scritto

nel foglietto dei cd riguardo alla licenza di
uso e distribuzione?
Non ci sono royalties né altro da pagare per i
CD realizzati. Il prodotto dà piena licenza di
redistribuzione dei lavori creati (come specifi-
cato nel file license.txt). Non è necessario
includere alcun foglio nei CD distribuiti (sei
pregato però di inserire uno dei loghi
"realizzato con HyperPublish", presenti nella
directory clipart o in http://hyperpublish.com/
ita/linktohp).

Ho un sito Web esistente che voglio mettere
su CDROM per la distribuzione con funzioni
di ricerca, posso importare il sito in Hyper-
Publish e usare il vostro motore di ricerca?
Sì, certo. Puoi importare file HTML dentro
HyperPublish, anche se a volte occorre rifor-
mattare, siccome HP rimuove alcuni tag in-
compatibili con tutti i  browser. Il modo mi-
gliore di usare HP sarebbe partire da zero,
creare un documento e quindi usare il pro-
gramma sia per pubblicare il sito che il CD:
in questo modo si risparmia molto tempo.
HP supporta database quando su CD?
No. Se avete queste esigenze, contattateci.

Ho diversi file PDF che voglio inserire su un
"reference CD". HyperPublish può impor-
tare file PDF? Se no, come posso mettere
link a file PDF?
Non si possono importare PDF ma si possono
collegare in modo semplice usando il co-
mando "run:", ad esempio puoi piazzare un
link del tipo "clic qui per leggere il docu-
mento XYZ", dove un clic lancerò il PDF
(cerca "Funzioni Avanzate CD" nell 'online
help). Puoi anche includere l'Acrobat Reader
sul CD e lanciarlo con lo stesso comando
"run:" (ad esempio puoi scrivere "clic qui per
installare l'Acrobat Reader se non riesci a
leggere i file PDF sul tuo sistema").

Posso usare Applet Java, Active X, Java-
script, VBScript o ASP quando creo un CD?
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Ho aggiunto un'applet e funziona nel brow-
ser ma non quando creo il CD.
Il browser interno di HP non può far girare
Applet, Active X o JS. Comunque se queste
cose ti servono puoi creare un CD esportando
in HTML, con "File >Esporta pagine".

Non capisco come creare un CD!
Prova a seguire passo passo il tutorial che
trovi nel manuale online e/o le istruzioni in
questo stesso manuale. E’ un’operazione
molto semplice!

Posso proteggere il CD con delle password?
No, però puoi prendere il programma
EbooksWriter (www.ebookswriter.com) che
legge i file di HyperPublish e consente di
proteggere lavori con password. I lavori creati
con EbooksWriter possono essere distribuiti
anche su CDROM.

Mi piacerebbe avere su una pagina un link
che dica "Documenti disponibili " e una volta
cliccata apra una cartella con diversi files
disponibili , pronti per essere cliccati. Sto
preparando un CD con centinaia di files, e
questa funzione sarebbe molto utile: creare
link per ogni file sarebbe un lavoro troppo
lungo.
Seleziona un blocco di testo, scegli "Inserisci
>Collegamento" dal menù principale, scegli
la terza linguetta, pulsante "Aggiungi +"
quindi invece di "http://.." scrivi "run:c:\path"
oppure "run:cddrive:\path" (nel secondo caso,
il programma rileva automaticamente il CD
drive - al momento dell ' installazione del pro-
gramma Reader, e sostituisce automatica-
mente la parola chiave cddrive con la corretta
lettera del drive).

Il vostro software gestisce direttamente i file
PDF o posso convertirli i n qualcos'altro? Le
industrie che rappresentiamo ci forniscono
tutte le documentazioni relative ai loro pro-
dotti in formato PDF.

Con HyperPublish è possibile creare un CD
ipermediale che faccia da "colla" a questi
PDF, permettendo di ordinarli e catalogarli .
HyperPublish non gestisce direttamente i
PDF, ma potete inserire collegamenti ad essi:
molti nostri clienti stanno usando HP per
gestire insiemi di PDF. Potete anche inserire
una pagina dove proponete all' util izzatore
l' installazione di Acrobat Reader (potrà essere
lanciato senza fastidiose conferme, vedere la
funzione run: nel capitolo Funzioni Avan-
zate).

A quanto ho capito (correggetemi se sbaglio)
HyperPublish permetterebbe alla mia
azienda di creare "Web CDs". Con questo
definisco un CD che è l'esatta copia di un
CD pubblicato con pagine multiple e tutte le
sue caratteristiche, JPEG's, frames, XTML,
Java script e database, in copia esatta.
Lo scopo di HyperPublish è leggermente di-
verso, Con HyperPublish si può editare un
singolo documento ricco di collegamenti
(pagine informative, cataloghi, manuali ), ed
eventualmente immagini, frames, rollover,
ecc. quindi pubblicarlo sia su Web che su
CD. Se si pubblica su CD, il programma
include un motore di ricerca "full text" cioè la
possibilit à di effettuare ricerche (anche con
operatori) sull' intero testo; oppure ricerche
con parola chiave. In sintesi HP è un pro-
gramma per fare entrambe le cose: procedere
sin dall ' inizio in questo senso è molto più
semplice che fare un sito Web con altri stru-
menti e poi come fa qualcuno cercare di tra-
sferirlo (spesso con scarso successo o risultati
poco professionali ) su CD.

HTML HELP, WINHELP
Ho dei problemi ad ottenere l'export *.HLP.
Qual è la differenza tra *.HJP ed *.HLP? Mi
sembra di ottenere solo *.HJP nell 'export, e
questo certamente non funziona come un file
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*.HLP.
HPJ (e gli altri files generati da Hyper Pu-
blish) devono essere compilati con il compila-
tore MS help compiler (HPC, HCW) per otte-
nere il file HLP. Per altre informazioni sul
compilatore MS help  vedere la sezione do-
mande frequenti  di www.hyperpublish.com/
ita/.

Ho dei problemi nel creare un file .CHM
(HTMLHelp)...
Verifica che il compilatore HTMLHelp Mi-
crosoft sia installato (vedi la sezione domande
frequenti di www.hyperpublish.com/ita per
altre informazioni). Se lo è, scegli "Pubblica
>Esporta pagine", quindi in alto scegli il  for-
mato "HTMLHelp". Nella linguetta path sce-
gli il  path dove verranno creati tutti i  file
temporanei che occorre, ad esempio c:\temp.
Premi quindi "Ok". Se il compilatore non
parte automaticamente, scegli con l'Explorer
di Windows c:\temp e fai doppio clic sul file
ilnomedeltuofile.hhp (a seconda di come è
configurato il tuo PC, l'estensione HHP po-
trebbe non essere visibile,e potrebbero esserci
3 file ilnomedeltuofile, se è così fai clic su
quello con l'icona a forma di tritatutto). Una
volta che Microsoft HTMLHelp Workshop è
partito, scegli "File >Compile", ed otterrai il
file .chm.

Quando compilo in HTMLHelp una finestra
non viene mostrata. Questa finestra invece
compare in HTML normale, o dentro Hyper-
Publish...
Basta inserire la pagina relativa da qualche
parte dentro la TOC "Ipertesto >Ordine pre-
definito pagine - TOC".

Posso usare un .CHM per un Help “ context
sensitive” ?
Sì. Il Context-ID (o Topic ID) per ciascuna
pagina è semplicemente il numero della pa-
gina. Vedi il  manuale del tuo ambiente di
programmazione per vedere come chiamare

un “ topic” HTML Help tramite Topic ID.

Cosa devo fare se voglio chiamare un Help
context-sensitive (cioè voglio chiamare una
data pagina quando l’utente preme F1), in
Delphi 3/5?
Scarica la unit che trovi nel sito Web alla
sezione “Domande frequenti” , aggiungila alla
sezione “uses” della tua applicazione/form.
Quindi usa “Project >Options” per assegnare
il nome del tuo file .CHM come “Help File
name” . Quindi inserisci il numero della pa-
gina da chiamare nella proprietà
“HelpContext” di ciascun controllo (allo
stesso modo in cui si fa per WinHelp; per
esempio inserire 2 se si vuole chiamare la
pagina 2).

HTML - APPLET - AEH - ASP
Qual è la procedura per intervenire diretta-
mente sull ' HTML di una pagina?
Non si può intervenire sull 'HTML se non con
aggiunte. HyperPublish è stato progettato con
un ottimizzatore interno compatibile con IE e
NS e siccome è un po' geloso, non permette
interferenze... Per aggiunte "Inserisci
> HTML", oppure all 'interno di un oggetto
usare "Proprietà" e la linguetta HTML (ad
esempio per le immagini tasto destro del
mouse, "Proprietà immagine").

Come fare per assegnare i nomi dei file,
caricandoli sul sito? Per esempio:
' pippo.html' invece che ' nome-aeh-000001' ?
Non si può "eliminare" il "naming" automa-
tico - serve per ottimizzare i trasferimenti (il
fatto che ogni pagina abbia un nome fisso
aiuta a risparmiare trasferimenti quando si
modifica una pagina). C'è però un altro modo:
basta inserire i l nome della pagina in
"Formato >Proprietà testo", nella casella gri-
gia in basso a sinistra. Si tratta fisicamente di
una redirezione, bytes consumati molto pochi.
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Per la “pagina principale” o “copertina” è
possibile cambiare il nome usando “ Ipertesto
>Proprietà dell ’ ipertesto corrente...” , linguetta
“ Impostazioni di pagina, sfondo” .

Cosa devo fare se voglio ottenere più pagine
Html, oppure se voglio un’anteprima diversa
da quella fornita dal pulsante “ Edit” ?
Si usa il menù "Pubblica", le varie opzioni
sono intuitive. E’ anche possibile pubblicare
direttamente con FTP.

Cosa posso fare con un "AEH"? Posso ve-
derlo solo con HyperPublish?
Un "AEH" si vede con HyperPublish e con
iPerReader TM (sullo stesso principio di Acro-
bat ed Acrobat Reader TM). Inoltre con
EBooksWriter ed altri programmi VisualVi-
sion. Un file AEH contiene un intero iperte-
sto. Siccome con il menù "Pubblica" è possi-
bile in ogni istante avere tutto convertito in
molte pagine Html o Rtf, AEH è un sistema
semplice e compatto per archiviare e scam-
biare i propri lavori usando un solo file.

Come posso inserire un’applet Java in una
pagina?
Con "Inserisci >HTML" inserisci il  codice
HTML relativo all ’applet. Invece del nome
del file class, cioè dove trovi clas-
sname="appletname.class" nel codice, scrivi
solo classname="", quindi piazza il cursore
fra gli apici e premi il  pulsante “ Inserisci rif.
a pagina o file” , quindi nella finestra che
appare scegli l a seconda linguetta e cerca il
file .class nell ’hard disk.

Posso gestire pagine ASP con HyperPu-
blish?
Certamente. Puoi usare “ Inserisci >Html >In
mezzo al testo” per inserire codice ASP. Poi-
ché HyperPublish usa “.htm” o ” .html” come
nome dei file, dovrai chiedere al responsabile
del tuo server di abilit are l’ASP anche sui file
con questa estensione.

DOWNLOAD / DOC / ZIP / PDF /
FLASH / ACCESSORI INTERNET /
CONTATORI / FORUM / IMPOR-
TARE FILE
E’ possibile inserire con HyperPublish un
download?
Sì, puoi farlo. Se vuoi far scaricare un file zip,
trasferisci lo zip sul sito, poi metti un link con
"Inserisci >collegamento" e dalla finestra che
ti compare scegli l a terza linguetta "Indirizzo
internet - Programma". Fai clic sul bottone
"Aggiungi" e digita l’ indirizzo dal quale far
scaricare il fi le (ad es. http://
www.miowww.it/download/pippo.zip ).

Come posso inserire una directory nel ser-
ver, ad esempio per raggruppare i file da
rendere disponibili per il download?
Per comodita' bisognerebbe prendere un pro-
gramma esterno di FTP (ad esempio WS_FTP
che è gratis). Lo si configura esattamente
come per l' FTP interno. Ci sono poi dei pul-
santi per creare directory. Anche in HP c' e' ,
nella finestra di FTP, un pulsante per creare
directory (in alto a dx, assomiglia al pulsante
presente in varie finestre di Windows).

Un lavoro in .doc, invece di aprirlo, voglio
farlo scaricare. Come faccio?
Devi seguire la procedura descritta per il
download; in molti casi la soluzione migliore
è zippare il .doc e renderlo scaricabile dal
sito.

Come mai cancello le risorse multimediali
ed il file AEH rimane delle stesse dimen-
sioni?
Non basta cancellare il li nk o il pulsante in
questione (ad esempio un video) con il doppio
CANC che elimina il pulsante. Mentre lavori,
HyperPublish crea un "album" includendoci
tutte le immagini e le risorse multimediali che
di volta in volta inserisci. Quindi il  fatto che
si è cancellato il li nk non comporta che sia
cancellato dall ’album il file che volevi impor-
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tare, proprio come la cancellazione di un’ im-
magine da una pagina non ne comporta la
cancellazione dall ’album. Ecco allora spie-
gato che le dimensioni del file rimangono le
stesse! La filosofia di HP è quella di avere un
file unico da gestire. Il file dunque cresce in
relazione a quello che ci si carica dentro
(anche se non utili zzato). Ecco dunque che se
si carica un file di 100 Mb (anche se viene
cancellato), il file aeh tiene in sé tutti e 100 i
Mb che si volevano visualizzare. Per cancel-
lare basta andare nel menu "Ipertesto"
> "Album immagini files pagine e cancella-
zioni" e fare clic sulla seconda linguetta
"Files". Comparirà l’elenco dell ’album a di-
sposizione. Basterà selezionare i files che non
occorrono (quello da 100 Mb per intenderci) e
dopo cliccare sul bottone "Cancella" poto
sulla destra in alto. Dalla pagina che compare
confermare la cancellazione del file e dopo
fare clic su "OK". Dalla successiva schermata
confermare con OK.

Posso salvare in PDF?
Indirettamente è possibile. Se hai il corretto
prodotto Adobe installato, puoi semplice-
mente scegliere "File >Stampa", e stampare
verso l' Acrobat Distill er. Altrimenti basta in-
stallare sul sistema una stampante PostScript
fittizia (qualsiasi Apple LaserJet per esem-
pio), stampare su FILE: anziché su LPT1,
salvare il file come nomefile.ps e poi usare
l' utilit y gratuita Ghostscript (la si trova per
esempio su volftp.mondadori.com) per con-
vertire da PS a PDF. Un comando Ghostscript
corretto su linea di comando DOS prompt è
gswin32c -q -d -dPDFSETTINGS=/printer -
dCompatibil ityLevel=1.3 -dNOPAUSE -
dBATCH -sDEVICE=pdfwrite -
sOutputFile=c:\nomeoutputfi le.pdf nome-
file.ps).

C'è qualche esempio per inserire parti in
Flash?
Sul sito web www.hyperpublish.com/ita alla

sezione domande frequenti puoi scaricare un
esempio semplice (file Flash inserito in un
ipertesto AEH); e  lo stesso esempio ma con il
file Flash esterno al file .aeh (il file Flash
dovrà essere messo sul sito separatamente,
con un programma FTP). Per creare il primo
esempio, nella finestra relativa al componente
che permette di inserire il codice HTML che
lancia flash (Inserisci >Applet / Active X),
invece di un riferimento diretto al file .swf, es.
"pippo.swf", abbiamo premuto il pulsante a
forma di dischetto, e cercato nel file system il
file pippo.swf. In questo modo il programma
piazza un riferimento dinamico ed include il
file .swf nell ' ipertesto .aeh.

Nella mia homepage del sito che sto co-
struendo ho inserito un contatore visite che
però debbo cambiare. Devo rifare tutta la
pagina?
Un contatore visite corrisponde a un codice
HTML, lo si può mettere con "Inserisci
>HTML". Per fare cambiamenti basta fare
clic sul blocchetto con il tasto dx del mouse e
scegliere "Proprietà" per cambiare l' HTML.

Sto cercando di inserire un modulo che gli
utenti dovrebbero completare per inviare
commenti al sito che dovrebbero essere vi-
sualizzati dagli altri visitatori, ma non so
come fare.
Hai bisogno di un "guestbook" o di un
"forum".
Questo tipo di strumenti interattivi richiedono
l' installazione sul server. Ce ne sono di gra-
tuiti disponibili t ramite moltissimi siti, ne
abbiamo raccolti a www.visualvision.it/utili/

Posso inserire una chat, o suonerie?
Trovi info a www.visualvision.it/utili/
Suonerie, chat, ecc. sono funzioni che vanno
impostate sul server, se non hai un accesso
diretto al server, devi usare servizi di terze
parti. Sono queste terze parti che solitamente
insegnano come inserire i loro servizi. Di
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solito danno dei codici HTML. I codici
HTML si possono inserire nel programma con
"Inserisci >HTML".

Come posso importare File da altri pro-
grammi?
Usa "File >Importa", quindi scegli un formato
(RTF; HTML; ASCII) , quindi cerca i file che
vuoi importare nel file system (parte sinistra
dello schermo) e trascinali sulla destra. Il
programma può importare più files per volta e
dividerli automaticamente in pagine. Usate
CTRL+ CTRL- dopo l'import per vedere le
pagine.
Il programma è progettato per creare sia siti
Web che CD; la funzione di Import a volte
ignora il formato del testo; sarebbe quindi
meglio usare il programma in modo nativo e
non editor esterni.

Quando importo RTF, con quale criterio il
sistema divide un singolo file in pagine, e
come decide di finire una pagina e comin-
ciarne un'altra?
Usa un criterio interno. Nel menù dei formati
disponibili per l'import si può scegliere un
file/una pagina o una pagina/una pagina. Se il
programma ritiene che una pagina sia troppo
lunga può fare altre divisioni. E' consigliabile
usare pagine corte per rendere il testo mag-
giormente fruibile.

Ho importato pagine RTF. Alcune hanno un
link "continua" alla fine ma non tutte.
Si suppone che tu scriva abitualmente le pa-
gine dentro al programma. Se le importi, il
programma cerca di mettere qualche collega-
mento per comodità, ma starebbe a te inserire
i collegamenti opportuni. Il programma è
molto potente e permette di inserire moltis-
sime varietà di collegamenti.

Dopo aver importato dei file, la prima pa-
gina è vuota e non riesco a toglierla.
Semplicemente, copia un'altra pagina dentro

di essa. La pagina 0 non si può cancellare. Si
può anche configurare l'ipertesto in modo che
la prima pagina (o "copertina") non sia la zero
("Ipertesto >Proprietà dell 'ipertesto corrente",
seconda linguetta, a sinistra "copertina").

Ho creato un documento e inserito diversi
collegamenti. Funzionano bene, ma in modo
"sola lettura" o in anteprima browser posso
vedere solo le pagine raggiungibili con link,
e non quelle non linkate.
Sì, è normale.

Abbiamo dei manuali utente creati usando
un altro programma. Se scegliamo di usare il
vostro software, potremo modificare e man-
tenere i vecchi manuali con il vostro pro-
gramma, o dovremo rifarli da capo?
Se il vostro vecchio programma può salvare
in RTF o HTML o ASCII (.txt) o almeno può
effettuare copia in cartella appunti, potrete
importare i dati nel vostro software (magari
con qualche riformattazione) e usarli .

Il programma può importare il formato
Word Perfect (WPF)?
Non direttamente, ma dentro Word Perfect
puoi scegliere "Salva come..." e salvare i tuoi
file in formato RTF, che può essere importato.

CARRELLO DELLA SPESA, E-
COMMERCE
Come posso inserire un carrello della
spesa?
Usa "Inserisci >Collegamento a carrello della
spesa".
Se desideri un carrello diverso, ci sono carrelli
della spesa gratis a http://www.jsdir.com/.
Usa “Inserisci >HTML >In mezzo al testo”
per inserire i codici HTML. Se hai bisogno di
un professionista che ti aiuti ad inserire co-
dici, http://www.darius.it
Se vuoi impostare il sito in modo da gestire
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acquisti tramite carta di credito, puoi chiedere
al tuo host. Ci sono service esterni che gesti-
scono questo tipo di servizi, ne trovi qualcuno
a http://www.upload.it scegliendo
“Registration services” .

HyperPublish ha una funzione per accettare
carte di credito online?
Questo tipo di servizio è fornito da diverse
banche o services. Con un conto diretto presso
una banca o Visa basta inserire un form e
qualche codice nelle tue pagine in modo da
accettare ordini (con “ Inserisci >HTML” puoi
inserire ogni tipo di codice, tipicamente i
codici sono forniti da chi presta il servizio).
Alcuni servizi di terza parti possono servire
ad accettare carte di credito online senza le
complicazioni dell ’ interazione diretta con una
banca (ad esempio clickbank.com, kagi.com )
e con il vantaggio di controlli antifrode.

Sto usando lo "Shopping Cart generator" (il
servizio carrello della spesa) che mi ha for-
nito il mio servizio di e-commerce, e sto
creando un pulsante "Acquista ora" per cia-
scun prodotto che vendo. Le istruzioni di-
cono "fai una copia del box premendo
CTRL+C. Quindi nei file del tuo sito Web,
apri i l codice per la pagina Web in cui
vorresti permettere i pagamenti. Incolla il
codice che hai appena copiato dentro al file
della pagina Web, nella posizione in cui vuoi
appaia il pulsante...". Siccome con HyperPu-
blish non sto usando direttamente l'HTML e
non so nulla di codici, non sono sicuro di
cosa fare. Mi potete aiutare?
In HyperPublish, posiziona i cursore nella
posizione dove vorresti inserire il pulsante
"Acquista ora",. Quindi usa "Inserisci
>HTML> In mezzo al testo". Il programma
visualizzerà una finestra dove potrai incollare
il codice fornito dallo "Shopping cart genera-
tor". Quindi premi OK. Vedrai che HP inseri-
sce un "blocchetto", una piccola icona nella
pagina. Quando pubblicherai sul sito (o in

anteprima browser) verrà visualizzato il pul-
sante di pagamento. Se in futuro vorrai modi-
ficare il codice, usa il tasto destro del mouse
sopra il blocchetto, quindi "Proprietà".

GENERICHE
Non trovo la risposta alla mia domanda!
Leggi bene tutto il manuale, e se non c' è,
chiedi al nostro indirizzo email !

Non riesco a cancellare diversi oggetti con
CANC...
In questo caso è necessario usare CANC due
volte.

La finestra XYZ appare troppo piccola, se-
condo me!
Ridimensionare la finestra con il mouse. Hy-
perPublish memorizza le dimensioni asse-
gnate ad ogni finestra.

Come posso vedere l'ipertesto su un brow-
ser?
Usare "Pubblica >Anteprima in browser"

Sto scrivendo un manuale di un'applicazione
e ho bisogno di ripetere più volte il l ogo e il
nome dell 'applicazione. C'è un modo veloce?
Creare una nuova pagina, inserire il nome e il
logo dell' applicazione. Quindi è possibile
usare "Modifica >Incolla pagina da..." per
inserire logo+scritta ovunque serva. Inoltre si
possono usare intestazione e piè di pagina
(qualsiasi pagina può essere usata come inte-
stazione o piè di un’altra pagina).

Non riesco a introdurre tabulazioni!
Usare i bottoni "riduci rientro" ed "aumenta
rientro".

Il copia e incolla ogni tanto non mantiene il
"formato" del testo.
Può succedere per testi corti. HyperPublish
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cerca di avere un comportamento intelli gente
in ragione dell 'operazione effettuata. Ogni
tanto il comportamento non è quello che l'u-
tente si aspetterebbe.

Posso inserire in pagine diverse testi e/o
immagini identiche per ogni pagina, come un
file "include" C?
Creare una nuova pagina e scrivere testo e
immagini.
Poi, per ogni pagina che deve contenere una
replica del testo, usare "Inserire >Html >In
mezzo al testo", quindi il  bottone "Inserisci
pagina nel testo". Fatto questo apparirà una
finestra in cui sarà possibile scegliere la pa-
gina da inserire.
Si noti che questo non è "visuale" e funziona
solo per la pubblicazione Html. Per un si-
stema più "visuale" vedere un'altra FAQ.

Come posso fare apparire finestre separate?
Si possono usare i Collegamenti speciali , op-
pure “ Inserisci >Funzioni di pagina >Lancia
finestre” .

In qualche pagina multi -frame Netscape si
blocca.
Questo è dovuto a un bug di qualche versione
di Netscape 4. Per evitarlo, usare “Formato
>Riformatta” su tutti i  paragrafi del frame che
provoca il blocco. Questa soluzione potrebbe
richiedere la definizione di qualche “stile”
addizionale (”Formato >Stili ...” ).

NS dice “ Javascript error, IperF_open not
found in page xxxx.htm” .
Modifica la pagina in HyperPublish e inseri-
sci un collegamento speciale che punti ad una
popup. Va bene anche un collegamento un
po’ nascosto, ad esempio un puntino bianco
su sfondo bianco.

In un ipertesto con molte immagini, mi sem-
bra ci siano problemi con le anteprima.
Usare “Strumenti >Opzioni programma” per

aumentare le impostazioni della cache imma-
gini.

Non riesco a “ minimizzare” l’applicazione.
Scegliere “Strumenti >Opzioni del pro-
gramma”, e premere “Azzera impostazioni
memorizzati per finestre”

Ho perso il file AEH di un sito, forse l' ho
cancellato. Come posso recuperare i file dal
sito?
Innanzitutto assicurati di avere davvero perso
il file AEH. La prima cosa è verificare se è
presente il file .BAK (si può abilit are/disabili -
tare in Strumenti >Opzioni del programma).
Il file .BAK contiene la penultima versione
del tuo lavoro. Cercalo con "Start >Trova
>File e cartelle": trovatolo fai un doppio clic
lento su di esso e cambia il nome, per esem-
pio da pippo.bak a pippo.aeh. Quindi aprilo
con il programma.
Se non trovi né AEH, né .BAK, la cosa più
semplice potrebbe essere recuperare le varie
pagine facendo copia e incolla da un browser.
Un altro sistema è usare un programma di
FTP, scaricare tutti i file sul tuo Hard Disk,
aprire un file nuovo in HP, scegliere "File
>Importa/apri pagine", scegliere come for-
mato "HTML", fare clic sulla l inguetta
"Importa seguendo collegamenti", introdurre
nella casella "parti da" il nome del file princi-
pale del sito (di solito index.htm) e il nome
della rispettiva cartella dell 'Hard Disk, quindi
impostare 10 come numero di li velli , premere
"Determina lista" e quindi "OK".

La mia esigenza è quella di creare una pa-
gina dove inserire una password per acce-
dere ad informazioni riservate che potranno
vedere solo le persone a cui verrà comuni-
cata la password...
Le pagine con "password" vanno impostate
dal lato server, vale a dire devi interpellare chi
ti fornisce lo spazio di hosting. Non è una
cosa che si possa configurare dentro un pro-
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gramma di creazione siti (in pratica è il cosid-
detto HTTP server, solitamente Apache o Mi-
crosoft IIS, che deve essere istruito su quali
pagine fornire a tutti, e quali solo sotto pas-
sword).

Quali sono le differenze fondamentali tra
HyperPublish (HP) ed EasyWebEditor
(EWE)?
EWE è solo per il Web, HP può anche creare
CDROM autoinstallanti con motore di ricerca
interno, ha più funzioni, non ha limiti sul
numero massimo di pagine in un singolo file
AEH (vedere www.visualvision.it per una ta-
bella di confronto)

Ho un vecchio PC a 200MHz, basta? Posso
gestire un sito trafficato con questo PC e
HP?
Gestire nel senso di costruire certamente. Per
ospitare il sito ti conviene affidarti ad un
servizio di hosting (ospitare il proprio sito in
casa è troppo costoso a causa delle attuali
tariffe Telecom per i collegamenti dedicati),
altre info a http://www.visualvision.it/come-
creareunsito

Avete un'edizione per Mac?
No

Ho un'icona per l'email - ho dato un'occhiata
ai tutorial ma non trovo come farla funzio-
nare!
E' semplice: seleziona l'immagine, tasto de-
stro del mouse, "Definisci collegamento", 3̂
l inguetta, "+ Aggiungi", scrivi
mailto:iltuoindirizzo@abc.it

Non riesco a far funzionare il controllo orto-
grafico!
Il programma usa il motore di controllo Mi-
crosoft. Qualche installazione di Office
2000/XP pasticcia le cose. Una soluzione
pratica può essere installare una vecchia ver-
sione di MSWord, ad esempio Word7.

Non riesco ad inserire GIF animate con
"Inserisci >Animazione"!
Usa semplicemente "Inserisci >Immagine".

Il programma dice “ Access Violation
XXXX” , quindi si pianta...
Facilmente hai troppe applicazioni aperte
(” troppe” può voler dire solo 4-5 in
Win98/ME...!). Chiudi qualche applicazione
o fa ripartire il computer.  Sfortunatamente il
numero XXXX (qualsiasi sia) è completa-
mente inutile. Se sei in grado di fornirci istru-
zioni precise per far ricapitare l'errore (ad
esempio, aprite il programma, scrivete
"topolino", premete "salva" e l'errore succede
SEMPRE) possiamo correggerlo. Spesso
l'AV non è un problema del programma ma di
MSWindows.

Posso mostrare una pagina esterna (di un
sito esterno) in un frame o in una popup?
Sì, crea una pagina / cornice / popup vuota,
quindi usa "Inserisci >HTML >Dentro al te-
sto" e inserisci questo codice:
<script language=javascript>
<!--
location.href="http://www.abc.com"
//-->
</script>
La pagina vuota verrà sostituita istantanea-
mente dalla URL esterna (http://
www.abc.com).
Usa parent.location.href="" nel caso in cui
desideri rimpiazzare un intero insieme cornici
(frame set).

La mia finestra popup funziona benissimo
nell ’anteprima, ma non funziona in rete, e
nemmeno nell ’anteprima su browser. Cosa
posso aver sbagliato?
Forse hai usato per la finestra un nome con
spazi o strani caratteri. Per favore usa qual-
cosa come “Topolino” come nome (senza “”).
"Mickey Mouse", "123bcd", "Mi$%/&" non
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sono identificatori validi.

Se passo in modalità sola lettura (Pulsante
Modifica / Anteprima), sembra che le diapo-
sitive non funzionino.
Occorre usare “ Ipertesto >Ricarica pagina”
per far partire la sequenza. Per avere questo la
prima volta che qualcuno legge un iperte-
sto,configura l’ ipertesto come “Sola lettura”,
in “ Ipertesto >Proprietà dell ’ ipertesto” .

Vorrei inserire alcune funzioni speciali che
richiedono script ma non sono capace a
scrivere script.
Hai bisogno di un professionista che ti aiuti
ad inserire codici, cerca sul Web.

Ho notato che in un mio lavoro in rete ridi-
mensionando le videate (più piccole) alcune
tabelle e immagini si spostano a capo e non
mantengono la posizione originaria. La pa-
gina non risulta un blocco unico. C'è una
soluzione al problema?
Bisogna fare un po' di pratica con l' uso di
tabelle "invisibili " per impaginare immagini e
testi. Bisogna assolutamente tenere conto del
fatto che non sono note a priori la dimensione
del monitor e della finestra di visualizzazione.
Alla fine del manuale ci sono alcuni consigli
utili per realizzare impaginazioni che si allar-
gano o restringono a seconda della risolu-
zione. Si tratta più che tutto di prenderci la
mano...

ACQUISTO - REGISTRAZIONE
Avendo creato una serie di pagine con il
trial, mi chiedo se con la versione definitiva
posso riprendere il mio progetto senza rifare
tutto.
Sì, certo.

Siccome ho acquistato, vorrei eliminare la
scritta posta sul fondo di ogni pagina pubbli -

cata riportante la scritta "VisualVision Hy-
perPublish..."
Facile, alla prima pubblicazione usando il
programma registrato, prima di premere
"Pubblica" seleziona nella finestra di pubbli -
cazione "Tutte" in basso a sinistra. In questo
modo il programma "rinfrescherà" tutte le
pagine (non solo quelle modificate), e la
scritta sparirà.

La chiave da voi fornita per la versione
elettronica non funziona
La chiave funziona con i dati inseriti . La
chiave DA SOLA non ha alcuna utilit à. Se
hai cambiato i dati, la chiave non è più valida:
usa quindi i dati elencati nell ' email di regi-
strazione.

Come posso acquistare HyperPublish?
Vai sul sito www.hyperpublish.com/ita e
compila il modulo d’ordine. Vendiamo in
tutto il mondo, su CD o per via elettronica.

Per qualsiasi altra domanda,
hyperpublish@visualvision.com
Buon lavoro!
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